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Overview

Saffa, a Hebrew Reference Guide, is an educational tool to aid in the learning of the 
Hebrew language.  It is both a Hebrew document production tool, as well as a resource 
for accessing grammatical features of the language.  Its features are useful for 
beginners and advanced students alike.

The Hebrew Editor is a dual-mode Editor, with both right-to-left and left-to-right 
capabilities within a single document. That is, the user is able to create documents in 
Hebrew on the right side of the page, with accompanying English text on the left-hand 

side.  Four fonts specifically designed for the program are included: HW Sephardi 2, 

HW Stam 2, HW David 2, and HW Noam 2.  The Editor will insert Hebrew 

consonants, vowels and diacritical marks, all positioned correctly, using only these 
four fonts - although like any Microsoft editor, any font installed on the system can be 
used.  The editor is also able to import Hebrew text from other sources, as long as that 
source can be copied to the clipboard in the Microsoft Hebrew Standard ASCII format.

Two powerful features of the editor are its lookup and speaking / transliteration 

capabilities.  Saffa can do a search for any word in a document and display all 

possible matches; and Saffa can display instantaneously a popup transliteration of any 

text in a document and pronounce it.  Additionally, Saffa can automatically generate 
transliterations of whole Hebrew documents and output the text according to the 
user’s specifications for formatting.

Documents

Saffa includes the entire Hebrew Bible (Ta-nakh, in Hebrew) of 39 Books, 
from Genesis through II Chronicles, divided into their corresponding 929 
files/chapters.  Each chapter contains the Hebrew verses on the right, 
and the English translation, based on the American Standard Version, on 
the left.  The verses on both sides are numbered for easy reference.

Saffa also comes with over 120 Documents in four other categories:

• Food Blessings

• Holiday Blessings/Songs

• T’fi-lot (Prayers)

• Torah Maf-ti-rim

(A Maftir is the last few lines of a Par-shah, or weekly Torah reading, found in the 
Khu-mash, the Five Books of Moses, often recited in a Bar/Bat Mitzvah ceremony).
The Torah Maf-ti-rim can be useful for those studying in preparation for the Bar/Bat 
Mitzvah ceremony.

Those with no previous knowledge of Hebrew can start with the Reading Tutorial.
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Those with some knowledge of Hebrew may want to use the Letter/Vowel 
Descriptions menu item to reference any gaps in their Hebrew-reading skills.

NOTE: The optimum screen resolutions for using Saffa are 1024 x 768 or 1152 x 864.

The major components of Saffa’s User Interface are shown in the following diagram:

All of Saffa’s User interface areas, aside from the Main pull-down Menu at the top, can be 
resized and docked/undocked (as floating windows).
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User Interface Areas

User Interface Area
Main Menu

Description

The main pull-down menu containing the following submenus: 
File menu
Grammar Table_menu
Edit menu
Format menu
View menu
Window menu
Preferences menu
Language Reference menu

Contents

File Toolbar Contains document-management, editing and printing commands.

Editor Toolbar Contains document formatting, transliteration and word-search commands.

Grammar Table Toolbar Contains commands for: printing, copying grammar forms, display of verb 
forms with/without vowels, alternate grammar forms, maximizing/restoring
view of grammar table windows.

Lookup/Search Toolbar A Tri-mode Search Area:
(a) Lookup a Hebrew entry in the alphabetical list of all database entries
(b) Search for all possible matches for a particular Hebrew word form
(c) Lookup an English definition keyword entry in the alphabetical database
entry list.

Grammar Tables Window Contains four tab sub-windows which access the grammar database:
Verb Table
Pronominal Suffixed Verbal Forms / Infinitive Noun Table
Preposition / Particle Table
Number Table

Editor Window A working area where multiple documents can be created and edited, using
the dual-mode Hebrew editor.

Overview Continued
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Lookup Tables/ Search 
Results Window

An area, linked to the Lookup/Search Toolbar, that shows the results of 
three different kinds of lookup searches:
(a) a listing of ALL Hebrew entries in the grammar database, in alphabetical
order
(b) the results of a search for a particular Hebrew word
(c) a listing of ALL English definition keywords of the database’s Hebrew 

entries

Keyboard Guides Window An area containing two tab sub-windows:
(a) the Hebrew Keyboard Guide
(b) the Hebrew Letter/Vowel Keymap Guide

End of Overview
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About command (Help menu)

Use this command to display the copyright notice and version number of your copy of 

SAFFA.

Addendum:

The Saffa Help.exe no longer functions on Windows 10 and other later versions.  This 
PDF file was created to suppliment and provide a User Guide with the same 
information found on the Saffa Help.exe but is now in PDF format.

On the left side of the PFD Reader the second Icon will list all information in 
alphabeticl order and the CONTENTS page lists all information which was found on 
the original Saffe Help.exe contents menu..  Each item in the Contents Menu is linked 
to pages containing related information.  Either may be used to obtain required links 
materials to assist in the understanding of function of the Saffa Hebrew Works 
Program.

This PDF was not created or published by Hebrew Works or it's staff but by a 
programa user for use by all individuals who desire a user's guide.  Created in Adobe 
Acrobat XI, this PDF can be opened with any of the many PDF readers available free 
on the Internet.

Information desired beyound the contents of this PDF Help File can be obtained 
directly from Hebrew Works as well as downloaded at http://hebewworks.com/

Hebrew Works is not responsible for the production of this User Guide or Help FIle  
and any errata or missing information is the responsibility of the maker of this PDF for 
which we appologize. .

All information contained in this PFD is the sole property of Hebrew Works and is 
Copyrite version 2.0.0.5,  2003 - 2008 and may not be used as otherwise intended 
without the writen express permission of Hebrew Works.

CONTACT INFORMATION - TECHNICAL SUPPORT

If you have purchased a copy of SAFFA, you are entitled to free technical support via 
email.

(If you are still evaluating your trial version, please feel free to email with your 
questions as well.)

The email address for technical support is support@HebrewWorks.com. 

When emailing, please place the word  SAFFA in your Subject line.
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Active Document Focus (Window menu)

Sets the Input Focus to the currently active Document.

Shortcut: Ctrl+0
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Window Arrange Icons Command

Use this command to arrange the icons for minimized windows at the bottom of the 
main window.  If there is an open document window at the bottom of the main window, 
then some or all of the icons may not be visible because they will be underneath this 
document window.
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Binyan ïééðá

In the Hebrew Verb System, there are seven íéðééðá (Binyanim: structures or

themes).  A particular Verb ùøåù Shoresh (root), may happen to use any or all of

these Binyanim.  A simple description of these are as follows:

ì÷  Kal Active, Simple.  Also known as ìòô Pa-al

ìòôð  Nif-al Generally speaking, the passive of ì÷  Kal

ìòéô  Pi-el Active, Intensive or Causative.

ìòåô  Pu-al Passive of ìòéô  Piel

ìòôúä  Hit-pa-el Reflexive.  Appears sometimes as ìòôúð  Nitpael

ìéòôä Hif-il Active, Causative.

ìòôåä Huf-al Passive of ìéòôä Hifil.
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Bold Command (Format menu)
Bold Toggle Button (Editor Toolbar)

If text is selected, will add the Bold Font Style to the selection if the first character 
selected is unbolded.
Alternately, if the first character is bolded, the command will remove the Bold Font 
Style from the selection.

If no text is selected, and Bold is selected (button) or checked (menu), the next 
character entered will be bolded.
Alternately, if Bold is unselected (button) or unchecked (menu), the next character 
entered will be unbolded.

Also, if no text is selected, clicking on the Bold button in the Editor Toolbar will toggle 
the setting.

Shortcuts
Key: Ctrl+B

Editor Toolbar: 

NOTE: When navigating through a document, the state of the Bold menu command 
(checked / unchecked) and the state of the Bold button in the Editor Toolbar (pressed 
down, or up) will reflect the style of the character upon which the cursor currently sits. 
If there is a selection, the first character of the selection determines this state.
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Cascade command (Window menu)

Use this command to arrange multiple opened windows in an overlapped fashion. 
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Colors Command / Dialog (Format menu)
Colors ComboBox (Editor Toolbar) 

When using the Colors ComboBox in the Editor Toolbar: 

If text is selected, will change all characters in the selection to the chosen color, while 
leaving the background color unaffected.

If no text is selected, the next character entered will have the chosen color.

The last item in the Color ComboBox is “More Colors...”, which will popup the Colors 
Dialog.  Any new color chosen will then be shown in this last item.

When using the Colors Command / Dialog from the Format Menu: 

If text is selected, will change all characters in the selection to the chosen text and 
background colors.

If no text is selected, the next character entered will have the chosen text and 
background colors.

Shortcut to set focus to the Color ComboBox in the Editor Toolbar: Ctrl+9

NOTE: When navigating through a document, the text color of the character upon 
which the cursor currently sits will be shown in the Color ComboBox in the Editor 
Toolbar.  If there is a selection, the text color of the first character of the selection will 
be shown in the ComboBox.  The same is true for the initial text and background colors 
when the Color Dialog pops up.
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Columns Command / Dialog (Format menu)

This command operates on lines, not characters.  If text is selected, any lines 

included in the selection, including partially selected lines, will be targeted by the 
columns operation.  If there is no selection, only the line on which the cursor currently 
sits will be affected.

The Columns Dialog allows the user to choose two parameters: number of columns 
(none, 2, 3 or 4) and gutter width between columns (the minimum gutter width is 1/8 
inch for inch-ruled paper sizes, or 3 mm for centimeter-ruled paper sizes).

NOTE: When the Columns Dialog pops up, the initial values shown will be that of the 
line on which the cursor currently sits.  If text is selected and the text spans more than 
one line, the Dialog will reflect the values of the first line of the selection.
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Copy command (Edit menu)
Copy command (Editor Window Context Menu)
Copy command (Hebrew Edit Controls Context Menu)

Copies selected text to the clipboard.

From a Hebrew Edit Control, the text is placed on the clipboard in two formats:

• Plain text (unformatted), and

• UNICODE Plain text (unformatted)

From a Document, the text is placed on the clipboard in the following three formats:

• RTF (Rich Text Format) text

• Plain text (unformatted), and

• UNICODE Plain text (unformatted)

Copying text to the clipboard replaces any text previously stored there.

NOTE:  Any Hebrew characters that are copied use the SAFFA Hebrew ASCII Format
.

Shortcuts

Editor Toolbar:
Key: CTRL+C
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Copy Definition command (Grammar Table menu)

This command displays a submenu from which the user can choose to copy any or all 
of the definitions of a word.  If a word definition has more than one entry, the menu 
items will be numbered in the same sequence and with the same numbers as each of 
the definitions.

NOTE:  The submenu can also be accessed via a context menu if you right click 

anywhere in the definition area (at the bottom of the grammar table).  See Definition 
(Grammar Table) Context Menu.

Return to Contents Page 16



Copy Selected Grammar Form command (Grammar Table menu)

This command copies a selected form in a conjugated/declined grammar table to the 
clipboard, including diacritical marks.

NOTE:  This command can also be accessed via a context menu if you right click on 

a word.  If the word contains the diacritical mark Metegâúî, then the user is given

the choice of copying the selected word to the clipboard with or without the Meteg.

Shortcut

Grammar Toolbar: 
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Copy Special command (Edit menu)
Copy Special Dialog
Copy Special command (Editor Window Context Menu)
Copy Special command (Hebrew Edit Controls Context Menu)

Pops up the Copy Special Dialog, which allows the user two preferences:

Direction: Forward / Reverse

Export Filter:  (1) None /  (2) Microsoft Hebrew Standard encoded text / 

(3) UTF-8 Unicode text. 

The Direction option is useful when copying between right-to-left and left-to-right 
applications or from one side of a SAFFA document to the other.

The Export Filter option is useful when copying from Saffa to another application that 

can import-paste text using the Microsoft Hebrew Standard or UTF-8 Unicode.

From a Hebrew Edit Control, the text is placed on the clipboard in two formats:

• Plain text (unformatted), and

• UNICODE Plain text (unformatted)

From a Document, the text is placed on the clipboard in the following three formats:

• RTF (Rich Text Format) text

• Plain text (unformatted), and

• UNICODE Plain text (unformatted)

Sequence Ordering Encoding Options
This is an option for how to encode the two visually identical, but different, letters:

The Vowel Kholam (when it appears with a Vav beneath it): pronounced OH; 
and

Vav vocalized with a Kholam (when the Kholam appears only as a Dot): 

pronounced VOH.

The first option (VAV + KHOLAM-DOT = KHOLAM) is used In most encoding 
specifications, and is the default option.

However, on occasion, when exporting as UTF-8 Unicode, one may require the 
second option (KHOLAM-DOT + VAV = KHOLAM).  For strictly word processing 
purposes, this setting does not matter.

For programs like Saffa, where the difference is recognizable through the 
pronunciations and transliterations, this setting may be crucial.

Shortcuts
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Editor Toolbar:
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Cut command (Edit menu)
Cut command (Editor Window Context Menu)
Cut command (Hebrew Edit Controls Context Menu)

Cuts selected text and copies it to the clipboard.

From a Hebrew Edit Control, the text is placed on the clipboard as plain text 
(unformatted), only.

From a Document, the text is placed on the clipboard both as RTF (Rich Text Format) 

text and as plain text (unformatted).

Cutting text to the clipboard replaces any text previously stored there.

NOTE:  Any Hebrew characters that are copied use the SAFFA Hebrew ASCII Format
.

Shortcuts

Editor Toolbar:
Key: CTRL+X
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Cycle Alternate Spellings command (Grammar Table menu)

If several forms exist for conjugated or declined grammar forms in a grammar table, 
this command cycles display of these alternate forms. If there are alternate forms, this 

is indicated by the initial display of the first form in RED.

Shortcuts

Grammar Toolbar: 

Keys:  Alt+A

NOTE:  Generally speaking, if an alternate form appears to be a loner in a grammar 

table, the form that is displayed first (in RED) is likely to be the most commonly-used 
form.  If, however, all or most forms of a particular tense have alternates, it is not 
necessarily the case that the forms first displayed are the most acceptable ones.
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ùâã  Dagesh

ùâã  Dagesh (meaning: emphasis, stress) is a dot within a Hebrew consonant.  In 

modern Hebrew, it changes pronunciation of the consonant only in the cases of  ¡ 
(Bet) and  ´ (Pey).

SAFFA can help you learn about this diacritical mark with the Letter/Vowel 
Descriptions and Reading Tutorial commands found under the Language 
Reference menu.
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Definition (Grammar Table) Context Menu

When one right-clicks on a definition or in the definition area at the bottom of a 
Grammar Table, a context menu pops up with anywhere from one to eleven or so 
menu items, depending upon the number of definitions.  The menu items let the user 
choose to copy any or all of the definitions of a word.  If a word definition has more 
than one entry, the menu items will be numbered in the same sequence and with the 
same numbers as each of the definitions.  Definitions are copied to the clipboard as 

both RTF text (Rich Text Format) and Plain Text (unformatted).

See Copy Definition command (Grammar Table menu)
HID_GRAM_COPYDEFINITION.
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Floating or Docking Windows

Docking windows have two display modes: floating or docked:

• In floating mode, a window has a thin title bar and can appear anywhere on your 
screen.  A floating window is always on top of all other windows.

• In docked mode, a window is fixed to a dock along any of the four borders of the 
main window.

To show or hide a docking window 

• To show or hide a docking window, click the name of the window on the View 

menu (Grammar Window, Lookup Window, Keyboard Window).

• To hide the window, click the Hide button in the corner of the window. This 
button may be at the upper-left or upper-right corner, depending on the position 
of the window. 

To expand or contract a docking window in its docking area 

• Click the Expand or Contract button near the corner of the window. This button 
may be near the upper-left or upper-right corner, depending on the position of 
the window. 

This is a dual-purpose button. When the window is fully expanded, the function 

of this button is Contract; otherwise, the function is Expand. The tooltip 
indicates the current function.

 To change a docked window to a floating window 

• Double-click on the single-grip bar in the window border. 

To dock a floating window 

• Double-click the window title bar to return the window to its previous docked 
location, or point to the title bar and drag the window to a different dock area. 
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To position a floating window over a dock (without docking it) 

There are two ways to do this:

1. Point to the title bar of the window.  Hold down the CTRL key, press the left 
mouse button down and drag the window over any dock area of the application 

window.  Keep the CTRL key held down until the you have released the 

mouse button, otherwise, the window will dock.

2. Right-click in the Title Bar to bring up the context menu.  Select Move.  Move 
the window using either the mouse or the arrow keys.  The window will NOT 
dock while being repositioned.

Resetting Docking Window Layout 

Docking windows can be a bit tricky.  There may be times when the user is unable 
to dock a window where he/she wishes.  In such cases, the View menu offers a 
command: Reset Docking Windows Layout.  This command resets the Docking 
Windows Layout with the Toolbars on top, the Grammar Tables Window just below to 
the left, and the Lookup/Search and Keyboard Windows at the bottom..
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Lookup/Search Toolbar Edit Control (Lookup/Search Toolbar)

The Edit Control of the Lookup/Search Toolbar 
works as follows, when in the following modes:

Hebrew List Lookup mode.  As the user enters Hebrew Text in the Toolbar’s 

Edit Control, the Lookup Tables Window scrolls to a matching or the 
closest alphabetical entry in the list of over 1,750,000 entries from SAFFA

’s Hebrew Word Database.

Hebrew Word Search mode.  The user enters Hebrew text in the Toolbar’s 

Edit Control and then presses the Enter key.  The program will then 

search SAFFA’s Hebrew Word Database, and display likely matches, 

ranked in order, in the Search Results Window, if found.  If no match is 
found, you may want to try removing the vowels from the search text and 
trying the search again.  A command to do this can be found in the Edit 

Control’s Context Menu:  Remove Vowels and Search.

English Definitions Keywords Lookup mode.  As the user enters English 

Text in the Toolbar’s Edit Control, the Lookup Tables Window scrolls to 

a matching or the closest alphabetical entry in the displayed list of 

approximately 25000 definition keywords from SAFFA’s Hebrew Word 

Database.

See Hebrew Word Database.

See Lookup/Search Toolbar.
See Lookup Tables/ Search Results Window.
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Edit menu commands

The Edit menu (visible when a document is open) offers the following commands:

Undo Reverses the previous editing operation.
Shortcut: Ctrl+Z

Redo Redo the previously undone editing operation.
Shortcut: Ctrl+Y

Select All Selects all text in the active side of the document

Cut Deletes the selected text from the document and copies it to the 
clipboard.
Shortcut: Ctrl+X

Copy Copies the selected text from the document to the clipboard.
Shortcut: Ctrl+C

Copy Special Pops up the Copy Special Dialog allowing the user to select two 
options for the Copy operation:  Export Filter (None, Microsoft Hebrew 
Standard) and Direction (Forward/Reverse).

Paste Pastes formatted text, if available, otherwise unformatted text, from the 
clipboard into the document.
Shortcut: Ctrl+V

Paste Special Pops up the Paste Special Dialog allowing the user to select various 
options for the Paste operation: Import Filter (None, Microsoft Hebrew 
Standard, DavkaWriter), Direction (Forward/Reverse), and Text Format
 (Plain Text /Rich Text Format).

Reverse Selected Text Reverses the letter order of the selected text.
Shortcut: Ctrl+Shift+R

Insert Page Break Inserts a Hard Page Break into a document.

Find Pops up the Modeless Find Dialog for a search for specified text in the 
document.
Shortcut: Ctrl+F

Find Next After setting up Search parameters using the Find command, finds the 
next instance of the specified text in the document.
Shortcut: F3

Replace Pops up the Modeless Find/Replace Dialog for a search for specified 
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find text and its replacement with specified replace text in the document.
Shortcut: Ctrl+L
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Replace Pops up the Modeless Find/Replace Dialog for a search for specified 
find text and its replacement with specified replace text in the document.

Shortcut: Ctrl+L
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Editor: Features

SAFFA’s dual-mode Hebrew Editor creates a document with two text buffers: one 

buffer allows right-to-left entry of text; the other allows left-to-right entry.  Essentially, 
the user is able to create documents in Hebrew on the right side of the page, with 
accompanying English text on the left-hand side.  By toggling the Hebrew/English 
Entry Mode button in the Editor Toolbar, or by using the main menu View ->7 Input 
Mode: Hebrew or View ->8 Input Mode: English  the user can alternate between 

these two modes.  In Hebrew Mode, the button shows the Hebrew letter Shin "ùùùù"; 

when in English mode, the button shows the letter "E".

Four fonts (referred to as “HW fonts”) specifically designed for the program are 
included: HW Sephardi 2, HW Stam 2, HW David 2, and HW Noam 2.  The Editor will 
insert Hebrew consonants, vowels and diacritical marks, all positioned correctly, using 
only these four fonts - although like any Microsoft editor, any font installed on the 
system can be used.  The editor is also able to import Hebrew text from other sources, 
as long as that source can be copied to the clipboard in the Microsoft Hebrew 
Standard ASCII format.  Exporting text is also possible.

The editor has two special features worth noting at this point:
1. The Column Feature supports columns across page boundaries.   What 

this means is that if you have a very long selection that occurs over several 
pages, then if you apply the column command to this selection, and the 
column height happens to be greater than the page height, the columns will 
ignore page boundaries.  That is, column one will extend onto the second, 
third, etc. page (whatever is required), and the top of column two will begin 
back on the first page.

2. Documents may contain different sized pages.   Although the most common 
usage of this feature will be to mix pages of different orientations (Portrait or 
Landscape), the editor supports display/printing pages of any size 
compatible with the system’s printers.

SAFFA does not currently support the placement of images or OLE objects in its 
documents.

Entering Hebrew text (using one of the four HW fonts)

In Insert Mode (default), Hebrew consonants will be entered into the document 
exactly as in English, a letter will appear ahead of the cursor, and the cursor will 
advance one letter.  When entering Hebrew vowels or diacritical marks, the vowel will 
modify the letter behind the cursor, and the cursor will not advance.   

In Replace Mode (press the Insert key on the keyboard), indicated by the appearance 
of OVR in the Status Bar Hebrew letters will be entered, as in English, replacing the 
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consonant ahead of the cursor, and the cursor will advance one letter.  At the end of 
the document, letters will be added as in Insert Mode.  Hebrew vowels and diacritical 
marks are entered as in Insert Mode. 

Editing operations

One may enter Hebrew text using either entry mode, however, when Hebrew text is 
entered using the left-to-right mode, the text will appear backwards.  Similarly when 
entering English text using the right-to-left mode, the text will be entered backwards.

The Editor supports a variety of Copy and Paste options, including:
RTF (Rich Text Format) / Plain Text (unformatted)
Forward / Reverse
SAFFA Hebrew ASCII Format or Import/Export as Microsoft Standard 
Hebrew ASCII Format encoded text. 

The standard Windows shortcuts also work in the Editor:
Ctrl + C Copy See Copy
Ctrl + V Paste See Paste
Ctrl + X Cut See Cut
Ctrl + Z Undo See Undo
Ctrl + Y Redo See Redo

See Edit Menu commands.

Formatting Text

The Editor supports many of the formatting features found in other word processors.  
Shortcuts include:

Ctrl + B Toggle Bold See Paste
Ctrl + I Toggle Italic See Cut
Ctrl + U Toggle Underline See Undo

Other formatting features include:
Different font typefaces, styles, and sizes
Various text and background colors.
Line Justification: Left, Right, Center
Extra Inter-Word Spacing
Extra Line Spacing
Columns
Page Setup: Paper size, Margins, and Tab Positions

The Editor contains both horizontal and vertical rulers at the top and left sides of each 
page.  Depending upon the paper size selected, these rulers will be marked in either 
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inches or centimeters.

See Format Menu commands.

Language Reference operations

If the Hebrew side of a document is active, there are several Language Reference 
operations available:

Hebrew Word Search will attempt a search of the word on which the cursor currently 
sits, and display any matches, if found.

Transliterate: Show Word will popup a transliteration of the current word.

Transliterate: Insert English Side  and Transliterate: New Document  will perform a 
formatted transliteration on the selected text, or if no text is selected, on the entire 
Hebrew side of the document, and either insert it at the cursor position in the English 
side of the same document, or open up a new document and insert it into the English 
side.

See Language Reference Menu commands .

Find and Replace

The Editor supports the normal Windows commands Find, Find/Replace and Find 
Again.  Keystroke shortcuts for these are:

Ctrl + F Find See Find
F3 Find Again See Find Next
Ctrl + L Replace See Replace

Navigating through the Document

The editor includes a number of special keystrokes for editing and moving around in a 
source file. These are in addition to the familiar ARROW keys, the SPACEBAR, and 
the ENTER key:

To move (to Press

Word to left CTRL+LEFT

Word to right CTRL+RIGHT

Beginning of current line HOME
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End of current line END

Beginning of document CTRL+HOME

End of document CTRL+END

Scroll up one line at a time.  Cursor will stay on the 
same line until it is on the bottom-most visible line, at 
which point, further scrolling will move the cursor, 
keeping it on the bottom-most visible line 

CTRL + UP Arrow

Scroll down one line at a time.  Cursor will stay on the 
same line until it is on the top-most visible line, at 
which point, further scrolling will move the cursor, 
keeping it on the top-most visible line

CTRL + DOWN Arrow

Tab Shortcuts:

When any text is selected:
1. All lines containing selected text will be indented one tab stop by pressing TAB.
2. Alternatively, all such lines will be un-indented one tab stop by pressing SHIFT + 
TAB.
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Editor Toolbar

The Editor Toolbar is displayed across the top of the application window, below the 

menu bar.  As a Docking Window, it may be moved anywhere within the main window 
or changed into a floating window.

There are two ways to display or hide the Toolbar:
1. From the Main Menu, Choose View -> Toolbar -> Editor Toolbar 

(Keystrokes: Alt+V, 1, E).
2. Right click in the Toolbar area or on any toolbar or toolbar button (but not 

an edit control or combobox), and select Edit Toolbar from the popup 
menu.

Click To

Toggles the Input Mode for the active document from the Hebrew 
(right-to-left) side to the English side, and vice-versa.  When the English side 

is active, the button displays the Letter E.  When the Hebrew side is active, 

the button displays the Hebrew letter Shin  ù.  This button performs the 

same actions as the two View menu commands: Input Mode: Hebrew and 

Input Mode: English.

Changes the Font Typeface of selected text.  See Font Typeface 
ComboBox (Editor Toolbar)

Changes the Font Size of selected text.  See Font Size ComboBox (Editor 

Toolbar)

 Toggles Bold setting for selected text.  See Bold Toggle Button (Editor 
Toolbar).

 Toggles Italic setting for selected text.  See Italic Toggle Button (Editor 
Toolbar).

 Toggles Underline setting for selected text.  See Underline Toggle Button 
(Editor Toolbar).

 Changes the color of selected text.  See Colors ComboBox (Editor 
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Toolbar)

Justifies selected lines left.  See Justify Left Toggle Button (Editor 
Toolbar)

 Justifies selected lines center.  See Justify Center Toggle Button (Editor 
Toolbar)

Justifies selected lines right.  See Justify Right Toggle Button (Editor 
Toolbar)

Speak and Transliterate Text.  See Speak/Transliterate: Text

Search for the selected word in the Database.  See Hebrew Word Search

Repeats/redoes the last editing operation.  See Redo Toggle Button 
(Editor Toolbar)

Reverses the last editing operation.  See Undo Toggle Button (Editor 
Toolbar)
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Editor Window Context Menu

When the user right-clicks with the mouse in a document, the following menu pops up.

Copy Copies the selected text from the document to the clipboard.
Shortcut: Ctrl+C

Copy Special Pops up the Copy Special Dialog allowing the user to select two 
options for the Copy operation:  Export Filter (None, Microsoft 
Hebrew Standard) and Direction (Forward/Reverse).

Paste Pastes formatted text, if available, otherwise unformatted text, from 
the clipboard into the document.
Shortcut: Ctrl+V

Paste Special Pops up the Paste Special Dialog allowing the user to select various 
options for the Paste operation: Import Filter (None, Microsoft 
Hebrew Standard, DavkaWriter), Direction (Forward/Reverse), and 
Text Format (Plain Text /Rich Text Format).

Select All Selects all text in the active side of the document

Cut Deletes the selected text from the document and copies it to the 
clipboard.
Shortcut: Ctrl+X

Hebrew Word Search This command is enabled when the Hebrew side of a document is 
active and the cursor is sitting on top of a word.

The command will first highlight the word in the document; then 
activate the Search/Match Word Button  in the Lookup/Search 
Toolbar; and then copy the word to the Toolbar’s Edit Control.  

SAFFA will then perform a search for the word in the Hebrew Word 
Database.  If matches are found, they will be displayed in the Lookup 
Tables/ Search Results Window .  Finally, the Grammar Tables 
Window will automatically display the first match in the list.

Shortcut: Ctrl+K

Hebrew Word Search – No 

Vowels

Works exactly like the Hebrew Word Search command above, except 
that the highlighted word is pasted into the Lookup/Search Toolbar’s

Edit Control without vowels and diacritical marks .  In most cases, 
this broadens the search and increases the likelihood of finding 
matches.

Shortcut: Ctrl+Shift+K
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See Editor Window
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English Definitions Keywords Lookup Button (Lookup/Search Toolbar)

Sets the mode of the mode of the Lookup/Search Toolbar to English 

Definitions Keywords Lookup mode.  The Lookup Tables / Search 

Results Window displays an alphabetical list of approximately 25000 

definition keywords from SAFFA’s Hebrew Word Database.  The Header

 displays 6 fields categorizing the entries.  As the user enters English 
Text in the Toolbar’s Edit Control, the Lookup Tables Window scrolls to a 

matching or the closest alphabetical entry in the list.

When the user then clicks on an entry, or highlights an entry and presses 

the Enter key, the Grammar Tables Window will normally display the 
associated grammar table, highlighting the keyword within the definition.  
There are cases, however, when a definition keyword for a verb is part of 
the definition of several of the verbs Binyanim.  In these situations, when 
the entry is clicked, a popup menu will appear, displaying the Binyanim 
where the definition keyword is found:

The user may then scroll in the list and press the Enter key, or click on 
one of the menu selections; the Grammar Tables Window will then 
display the entry, and highlight the keyword within the definition.

See Lookup/Search Toolbar.

See Lookup Tables/ Search Results Window.
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Input Mode: English command (View menu)

Sets the Input Mode for the active document to the English (left-to-right) side.

NOTE:  The same action can be performed by pressing the Toggle Input Mode button
HID_ENTRY_MODE in the Editor Toolbar.

Shortcut: Ctrl+E

See Editor Window.
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Extra Inter-Word Spacing Command /Dialog (Format menu)

This command operates on a character-by-character basis.

The range of unit values is from 0 through 99, with one unit equal to ¼ typeface point.

When text is selected, will increase the size of space characters within the selection by 
the number of units chosen.  If any characters within that selection are later changed 
to spaces, those spaces will also have the extra width characteristic.

The Command is enabled only if a space is contained within the text selection.

NOTE: When the Extra Inter-Word Spacing Dialog pops up, the initial value shown will 
be that of the first character of a selection; or if there is no selection, the value of the 
character upon which the cursor currently sits.
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Extra Line Spacing Command / Dialog (Format menu)

This command operates on lines, not characters.  If text is selected, any lines 
included in the selection, including  partially selected lines , will be targeted by the 
Extra Line Spacing operation.  If there is no selection, only the line on which the cursor 
currently sits will be affected.

The Extra Line Spacing Dialog allows percent values between 0 and 300.  This value 
is the percentage of the height of the line.  For example, if a value of 20 is selected, 
the distance between the line and the next line is increased by an extra 20%.  If more 
than one font occurs in a line, the line height will be determined by the tallest font.

NOTE: When the Extra Line Spacing Dialog pops up, the initial value shown will be 
that of the line on which the cursor currently sits.  If text is selected and the text spans 
more than one line, the Dialog will reflect the value of the first line of the selection.
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1 (2,3,4,5,6,7,8,9,0) Recent File Name (File menu)

Use the numbers and filenames listed at the bottom of the File menu to open any of 
the last 10 documents you closed.  Choose the number that corresponds to the 
document you want to open.
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Close All command (File menu)

Use this command to close all open documents.  If any documents have been edited 
and not saved, SAFFA will ask whether to save changes to the documents before 
closing them.  Answering No to the prompt will close the documents without saving, 
and you will lose all changes made since the last time the documents were saved.  
Before closing any untitled documents, SAFFA will display the File Save As Dialog 
and give you the opportunity to rename and save them.
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Close command (File menu)

Use this command to close the active document.  SAFFA suggests that you save 
changes to your document before you close it.  If you close a document without saving, 
you lose all changes made since the last time you saved it.  Before closing an untitled 

document, SAFFA displays the File Save As Dialog and suggests that you name and 
save the document.

Shortcuts
Mouse: Click the Close Icon in the Document Window’s Title Bar.

Keys: CTRL+F4
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File menu commands

The File menu offers the following commands:

New Creates a new blank document.
Shortcut: Ctrl+N

Open Pops up the File Open Dialog, which allows the user to 
navigate the file system and open an existing file.
Shortcut: Ctrl+O

Close Closes an opened document.
Shortcut: Ctrl+F4

Close All Closes All opened documents.

Save Saves an opened document using the same file name.
Shortcut: Ctrl+S

Save As Pops up the File Save As Dialog, which allows the user to 
navigate the file system, save the active document, and choose 
a Windows system file name, and an optional internal Hebrew 
File Name.

Print Prints a document, if a document is open.  Otherwise it pops up 
the Page Settings Property Sheet (Grammar Table Toolbar: 
Print), which allows the user to print or preview the currently 
displayed grammar table.
Shortcut: Ctrl+P

Print Preview Displays the document on the screen as it would appear printed.

Print Setup Pops up the Print Setup Dialog, which allows the user to select 
a printer, printer connection, paper size, paper source, 
orientation and other properties.

1 (2,3,4,5,6,7,8,9,0) Recent 
File Name

Opens one of the last 10 most-recently opened documents.

Exit Exits SAFFA.
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File menu commands

The File menu offers the following commands:

New Creates a new blank document.
Shortcut: Ctrl+N

Open Pops up the File Open Dialog, which allows the user to 
navigate the file system and open an existing file.
Shortcut: Ctrl+O

Close Closes an opened document.
Shortcut: Ctrl+F4

Close All Closes All opened documents.

Save Saves an opened document using the same file name.
Shortcut: Ctrl+S

Save As Pops up the File Save As Dialog, which allows the user to 
navigate the file system, save the active document, and choose 
a Windows system file name, and an optional internal Hebrew 
File Name.

Print Prints a document, if a document is open.  Otherwise it pops up 
the Page Settings Property Sheet (Grammar Table Toolbar: 
Print), which allows the user to print or preview the currently 
displayed grammar table.
Shortcut: Ctrl+P

Print Preview Displays the document on the screen as it would appear printed.

Print Setup Pops up the Print Setup Dialog, which allows the user to select 
a printer, printer connection, paper size, paper source, 
orientation and other properties.

1 (2,3,4,5,6,7,8,9,0) Recent 
File Name

Opens one of the last 10 most-recently opened documents.

Exit Exits SAFFA.
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New command (File menu)

Use this command to create a new blank document.

You can open an existing document with the Open command.

Shortcuts

File Toolbar:

Keys: CTRL+N

Return to Contents Page 48



Open command (File menu)

This command pops up the File Open Dialog, which allows the user to navigate the 
file system and open an existing file.

SAFFA allows you to open several documents and view them all at the same time.

Shortcuts

File Toolbar:

Keys: CTRL+O
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File Open Dialog

The File Open Dialog works very much like the standard File Open Dialog in 
Windows.  There are several differences, though:

1. The list of files appears only as Details, with header fields, and cannot 
be viewed as an Icon List.

2. The Details header fields includes an additional field called Hebrew 
Name, under which an optional internal Hebrew Name associated with a 
SAFFA document is displayed.

3. Because this Internal Hebrew Name can only be found by looking inside 
the file, loading of directories with large numbers of files may be 
noticeably slower than a normal Windows File Open Dialog.

SAFFA’s File Open Dialog contains four buttons at the top to the right of the Look in 

ComboBox:

The Up One Level button, which opens the Parent Directory.

The Create New Folder button creates a New Folder in the current 
directory.

The Rename button lets the user rename the selected File or Folder in 
the current directory.

The Delete button lets the user delete the selected File or Folder in the 
current directory.  A warning always pops up in case this button is 
pressed accidentally.  The deleted file is sent to the recycle bin.

The Rename and Delete commands are also available via a context menu when one 
right-clicks on an individual file or folder.  See File Open/Save As Dialog Context 
Menu.

The Look in ComboBox allows the user to navigate the file system to choose a 
directory.

The Files of Type ComboBox lets the user pick a file extension pattern to match to 
display some or all of the current directory ’s files and subfolders.

The Show Hidden Files and Directories  checkbox at the bottom, if checked, will 
update the list and display system folders and files as well.

The File Name Edit Control allows the user to type in directly the name of a file one 
wishes to open.  If the file exists, hitting the Return key or pressing the Open button 
will open that file.  If the file does not exist, or if there are wild cards within the text, 
only those files (if any) that match the file pattern will be displayed.  If the text is a 
directory path, that directory will be displayed.  Note that as one scrolls through the list 
of displayed files, the name of the file in the File Name Edit Control is update to match 
the current selection.
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The header of the List Control contains five fields: Name, Hebrew Name, Modified, 
Size and Type.  Clicking on any of these headers will order the list in alphabetical, 
smallest to largest, or least-recent to most-recent order, depending upon the field 
clicked.  Clicking on the field again will reverse that order.

Double-clicking on the divider  immediately to the right of a header field will resize 
that field’s column so that all items in that column are minimally visible.
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File Open/Save As Dialog Context Menu

When one right-clicks in either the File Open Dialog for File Save As Dialog, a 
context menu will popup displaying two choices: Delete and Rename.  These 
commands perform identical actions to the Delete and Rename Buttons in the upper 
right of the Dialogs, deleting or renaming the selected file or folder.

See File Open Dialog.
See File Save As Dialog.

Return to Contents Page 52



Save As command (File menu)

Use this command to save and name the active document.  SAFFA displays the File 

Save As Dialog, which allows the user to navigate the file system, save the active 
document and choose a Windows system file name, and an optional internal Hebrew 
File Name.

To save a document with its existing name and directory, use the Save command.

NOTE:  When a document is saved, the Undo/Redo List is emptied and it is no longer 
possible to undo/redo prior editing operations.

See Redo command (Edit menu)

See Undo command (Edit menu)
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Save command (File menu)

Use this command to save the active document using its current name and directory.  
When you save a document for the first time, SAFFA displays the File Save As Dialog
 so you can name your document.  If you want to change the name and directory of an 
existing document before you save it, choose the Save As command.

Shortcuts

File Toolbar
Keys: CTRL+S

NOTE:  When a document is saved, the Undo/Redo List is emptied and it is no longer 
possible to undo/redo prior editing operations.

See Redo command (Edit menu)
See Undo command (Edit menu)
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File Save As Dialog

The File Save As Dialog works very much like the standard File Save As Dialog in 
Windows.  There are several differences, though:

1. The list of files appears only as Details, with header fields, and cannot 
be viewed as an Icon List.

2. The Details header fields includes an additional field called Hebrew 
Name, under which an optional internal Hebrew Name associated with a 
SAFFA document is displayed.

3. Because this Internal Hebrew Name can only be found by looking inside 
the file, loading of directories with large numbers of files may be 
noticeably slower than a normal Windows File Save As Dialog.

SAFFA’s File Save As Dialog contains four buttons at the top to the right of the Look 

in ComboBox:

The Up One Level button, which opens the Parent Directory.

The Create New Folder button creates a New Folder in the current 
directory.

The Rename button lets the user rename the selected File or Folder in 
the current directory.

The Delete button lets the user delete the selected File or Folder in the 
current directory.  A warning always pops up in case this button is 
pressed accidentally.  The deleted file is sent to the recycle bin.

The Rename and Delete commands are also available via a context menu when one 
right-clicks on an individual file or folder.  See File Open/Save As Dialog Context 
Menu.

The Look in ComboBox allows the user to navigate the file system to choose a 
directory in which to store the document.

The Save as Type ComboBox performs two functions:  1.)  It allows the user to 
choose a file extension pattern to match to display some or all of the current directory ’

s files and subfolders;  2)  If the file name typed in the File Name Edit Control has no 
extension, the extension currently selected in the Save as Type ComboBox (excluding 
the specification *.*) will be appended.

SAFFA can save documents in three file formats: Plain Text (unformatted, extension=
.txt), RTF (Rich Text Format, extension=.rtf), and SAFFA-Format (a proprietary 
format that can only be displayed properly by this program, extension= .saf).  If the 
extension is neither .txt nor .rtf, then the document will be saved as SAFFA-Format 
file by default, regardless of whether it has the .saf extension or not.

The Show Hidden Files and Directories  checkbox at the bottom, if checked, will 
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update the list and display system folders and files as well.

The Hebrew File Name Edit Control allows the user to save a SAFFA-Format file with 
an optional Hebrew name.  The name may be entered using either the keyboard or the 
Keyboard Guides Window .  A third option is copy Hebrew text from the document 
before opening the File Save As Dialog, and then to paste it from the clipboard.

The File Name Edit Control allows the user to type in directly a file name to be used to 
save the document.  If the document has never been saved and the file name already 
exists, then the user will be prompted to overwrite the existing file.  If the file name has 
not already been used, the document will be saved using that file name.  If the text in 
the edit control is a pattern specification with wild cards (* or ?), then hitting the Return 
key or pressing the Open button will display only those files (if any) that match the 
pattern.  If the text is a directory path, that directory will be displayed.  Note that as one 
scrolls through the list of displayed files, the name of the file in the File Name Edit 
Control is updated to match the current selection.

The header of the List Control contains five fields: Name, Hebrew Name, Modified, 
Size and Type.  Clicking on any of these headers will order the list in alphabetical, 
smallest to largest, or least-recent to most-recent order, depending upon the field 
clicked.  Clicking on the field again will reverse that order.

Double-clicking on the divider  immediately to the right of a header field will resize 
that field’s column so that all items in that column are minimally visible.
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File Toolbar

The File Toolbar is displayed across the top of the application window, below the menu 

bar.  As a Docking Window, it may be moved anywhere within the main window or 
changed into a floating window.

There are two ways to display or hide the Toolbar:
1. From the Main Menu, Choose View -> Toolbar -> File Toolbar 

(Keystrokes: Alt+V, 1, F).
2. Right click in the Toolbar area or on any toolbar or toolbar button (but not 

an edit control or combobox), and Select File Toolbar from the popup 
menu.

Click To

Open (create) a New Document.

See New command (File menu)

Open an existing document.  SAFFA displays the Open Dialog, via which 
you can browse the folder system to locate and open the desired file.

See Open command (File menu)

Save the active document or template with its current name.  If you have not 

previously saved the document, SAFFA displays the Save As Dialog.

See Save command (File menu)
See Save As command (File menu)

Cuts selected text from the document and copies it to the clipboard in two 
standard formats:

RTF (Rich Text Format)

Plain Text (unformatted)

See Cut command (Edit menu)

Copies selected text from the document to the clipboard in two standard 
formats:

RTF (Rich Text Format)

Plain Text (unformatted)

See Copy command (Edit menu)
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Pops up the Copy Special Dialog, which gives options for 

copying selected text to the clipboard (text is copied in both RTF and Plain 

Text formats):

Forward / Reverse

SAFFA Hebrew ASCII Format /  Exported as Microsoft Standard Hebrew 
ASCII Format encoded text. 

See Copy Special command (Edit menu)

Pastes text from the clipboard as RTF (Rich Text Format) text after the 
cursor position.

See Paste command (Edit menu)

Pops up the Paste Special Dialog, which gives options for 
pasting clipboard text after the cursor: 

RTF (Rich Text Format) / Plain Text (unformatted)

Forward / Reverse
SAFFA Hebrew ASCII Format /  Exported as Microsoft Standard Hebrew 
ASCII Format encoded text. 

See Paste Special command (Edit menu)

Prints the active document.  If no document is open, Prints the Active 
Grammar Table.

See Print command (File menu)

Pops up the About Dialog.  This Dialog, which also appears at program 
startup, displays program information such as the version number, copyright, 
etc.

See About command (Help menu)

Context Sensitive Help.  After the user clicks on this button, a Question 
Mark symbol appears to the right of the cursor arrow.  When the user next 
clicks on a button or other control (edit, combobox), menu item, toolbar or 
window, a Help Topic concerning that item will popup.

See Context Sensitive Help command (Help menu)
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Find command (Edit menu)
Find Dialog

The Find Dialog lets the user search the active document for either English or 
Hebrew text.

When the English radio button  is checked, the user may enter English text from the 
keyboard.

When the Hebrew radio button is checked, the user may enter Hebrew text using 
either the keyboard or one of the Keyboard Guides.

Text is entered into the Find What Edit Control.  Pressing the Down Arrow to its right 
displays a list of the 10 most-recent Find What texts.

The user may do forward searches by checking the Down radio button ; or reverse 
searches by checking the Up radio button.

When doing searches for English text, the user has two options:
Match Whole Word Only
Match Case.

When doing searches for Hebrew text, the user has three options:
Match Whole Word Only
Match Vowels
Match Dagesh.

These options are explained below:
Match Whole Word Only If checked, the search will match only if the search 

text is not part of a larger word.  Punctuation is treated like white space.
Match Case If checked, the search is case-sensitive (English text only)
Match Vowels If checked, the search is vowel-sensitive.  A 

consonant/vowel pair in the search text must match its counterpart ’s 

consonant/vowel pair in order to match.  When considering whether to 

match, the Diacritical mark âúî  Meteg is ignored; that is, vowels with 

Meteg will match the same vowel without Meteg.  If this option is 
unchecked, the search will ignore Hebrew vowels altogether.

Match Dagesh If checked, the search is ùâã  Dagesh-sensitive.  

Consonants will match only if they both have or both don ’t have the 

diacritical mark Dagesh.  If this option is unchecked, the search will 
ignore Dagesh marks within a consonant.

The user can repeat the search for the next instance of the search text by pressing the 
Find Next button.
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Shortcut
Key: Ctrl + F
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Floating or Docking Windows

Docking windows have two display modes: floating or docked:

• In floating mode, a window has a thin title bar and can appear anywhere on your 
screen.  A floating window is always on top of all other windows.

• In docked mode, a window is fixed to a dock along any of the four borders of the 
main window.

To show or hide a docking window 

• To show or hide a docking window, click the name of the window on the View 

menu (Grammar Window, Lookup Window, Keyboard Window).

• To hide the window, click the Hide button in the corner of the window. This 
button may be at the upper-left or upper-right corner, depending on the position 
of the window. 

To expand or contract a docking window in its docking area 

• Click the Expand or Contract button near the corner of the window. This button 
may be near the upper-left or upper-right corner, depending on the position of 
the window. 

This is a dual-purpose button. When the window is fully expanded, the function 

of this button is Contract; otherwise, the function is Expand. The tooltip 
indicates the current function.

 To change a docked window to a floating window 

• Double-click on the single-grip bar in the window border. 

To dock a floating window 

• Double-click the window title bar to return the window to its previous docked 
location, or point to the title bar and drag the window to a different dock area. 
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To position a floating window over a dock (without docking it) 

There are two ways to do this:

1. Point to the title bar of the window.  Hold down the CTRL key, press the left 
mouse button down and drag the window over any dock area of the application 

window.  Keep the CTRL key held down until the you have released the 

mouse button, otherwise, the window will dock.

2. Right-click in the Title Bar to bring up the context menu.  Select Move.  Move 
the window using either the mouse or the arrow keys.  The window will NOT 
dock while being repositioned.

Resetting Docking Window Layout 

Docking windows can be a bit tricky.  There may be times when the user is unable 
to dock a window where he/she wishes.  In such cases, the View menu offers a 
command: Reset Docking Windows Layout.  This command resets the Docking 
Windows Layout with the Toolbars on top, the Grammar Tables Window just below to 
the left, and the Lookup/Search and Keyboard Windows at the bottom..
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Font: Typeface, Size, Style Command / Dialog (Format menu)

If text is selected, will change all characters in the selection to the chosen font 
typeface (font name), size, and style.

If no text is selected, the next character entered will have the chosen font 
characteristics.

NOTE: When the Font Dialog pops up, the initial font characteristics shown will be that 
of the first character of a selection, or if there is no selection, the font typeface, size 
and style of the character upon which the cursor currently sits.
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Font Size Command / Dialog (Format menu)
Font Size ComboBox (Editor Toolbar)

If text is selected, will change all characters in the selection to the chosen font size, 
while leaving other font characteristics the same.

If no text is selected, the next character entered will be the chosen font size.

Shortcut to set focus to the Font Size ComboBox in the Editor Toolbar: Ctrl+8

NOTE: When navigating through a document, the font size of the character upon 
which the cursor currently sits will be shown in the Font Size ComboBox in the Editor 
Toolbar.  If there is a selection, the font size of the first character of the selection will 
be shown in the ComboBox.  The same is true for the initial font size when the Font 
Size Dialog pops up.
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Font Typeface Command / Dialog (Format menu)
Font Typeface ComboBox (Editor Toolbar)

If text is selected, will change all characters in the selection to the chosen font typeface 
(font name), while leaving other font characteristics the same.

If no text is selected, the next character entered will be of the chosen font typeface.

Shortcut to set focus to the Font Typeface ComboBox in the Editor Toolbar: Ctrl+7

NOTE: When navigating through a document, the font typeface of the character upon 
which the cursor currently sits will be shown in the Font Typeface ComboBox in the 
Editor Toolbar.  If there is a selection, the font typeface of the first character of the 
selection will be shown in the ComboBox.  The same is true for the initial font typeface 
when the Font Typeface Dialog pops up.
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Format menu commands

The Format menu (visible when a document is open) offers the following commands:

Bold Adds (if checked/selected) or removes-  Bold (if 
unchecked/unselected) from selected text.  If no text is 
selected, sets Bold setting for the next character to be 
input.
Shortcut: Ctrl+B

Italic Adds (if checked/selected) or removes Italic c (if 
unchecked/unselected) from selected Text.  If no text is 
selected, sets Italic setting for the next character to be 
input.
Shortcut: Ctrl+I

Underline Adds (if checked/selected) or removes Underlines (if 
unchecked/unselected) from selected Text.  If no text is 
selected, sets Underline setting for the next character to 
be input.
Shortcut: Ctrl+U

Justify Text Sets Justification (Left, Right, Center) on a line-by-line 
basis.  If text is selected, all corresponding lines are 
affected.  If no text is selected, justification is set for the 
line on which the cursor resides.

Font Size Pops up the Font Size Dialog, allowing the user to 
change only the font size of selected text.  If no text is 
selected, sets the font size for the next character to be 
input.

Font Typeface Pops up the Font Size Dialog, allowing the user to 
change only the font typeface of selected text.  If no text is 
selected, sets the font typeface for the next character to 
be input.

Font (Typeface, Size, 
Style)

Pops up the Fonts Dialog, allowing the user to change all 
parameters of a font (typeface, size and style) for 
selected text.  If no text is selected, sets the font for the 
next character to be input.

Switch Font Allows the user, while editing, to quickly switch back and 
forth to fonts used previously in the active document.  
Useful as an alternative to locating and selecting the 
same font in the toolbar.  If more than two fonts have 
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same font in the toolbar.  If more than two fonts have 

been used, the command will Pop up the Switch to 

Previously Used Font Dialog
Shortcut: Ctrl+Shift+F

Colors Pops up the Colors Dialog, allowing the user to change 
the foreground and background colors for selected text.  If 
no text is selected, sets the colors for the next character 
to be input.

Columns Pops up the Columns Dialog allowing the user to set 
number of columns and gutter width parameters.  These 
will be used to divides the lines of selected text into 
evenly spaced columns.  A special feature of this 
formatting command is that columns will cross (i.e. ignore) 
page boundaries, if necessary.

Extra Inter-Word Spacing.. Pops up the Extra Inter-Word Spacing Dialog, allowing 
the user to enter increments of a ¼ point for increasing 
spacing between adjacent words.  Affects all word spaces 
in selected text.

Extra Line Spacing.. Pops up the Extra Line Spacing Dialog, allowing the 
user to enter percentages of line heights for increasing 
spacing between adjacent lines.  Affects all lines in 
selected text.  If no text is selected, affects line height for 
the line on which the cursor resides.

Page Setup Pops up the Document Page Settings Property Sheet, 
which allows the user to select page size, margins, and 
tab settings for the Hebrew side, the English side, or both 
sides of specified pages in a document.
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Full View / Restore command (Grammar Table menu)

Whether the Grammar Tables Window is floating or docked, this command toggles the 
visible area of the displayed Grammar Table to Full View – that is, enlarges or shrinks 

the window so that the entire table, but no extra space, is visible.  If the Window is in 
Full View, the command restores the window size to the last size set by the user using 
a mouse-drag operation.

NOTE:  When the Docking Windows and Toolbars are arranged in the same layout as 

when the program was installed (See View menu Commands: Reset Docking 
Windows Layout), the toggle action can be seen properly.  Sometimes, the windows 
are docked such that one dimension cannot be adjusted.  If toggling with this 
command does not produce the desired results, this is probably the case and can be 
confirmed by failure of the mouse to drag the side that refuses to move.

Also if the screen resolution for your monitor is set to 800 x 600 or less, the Restore 

part of this command may not work.  This happens because when the Full View 
command tries to resize a large Grammar Table, such as the Verb Table, the full 
height is never reached because the window would actually be taller than the vertical 
screen resolution setting.  Therefore repeating this command keeps trying to set the 

full height.  The optimum screen resolutions for using SAFFA are 1024 x 768 or 1152 x 
864.

Shortcut

Grammar Toolbar: 
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Grammar Form (Grammar Table) Context Menu

When one right-clicks on a grammar form in a Grammar Table, a context menu pops 
up with one to four menu items.

1.  The first menu item is always Copy to Clipboard.

2.  If the grammar form contains a Meteg âúî , then the second menu item  will be 

Copy to Clipboard (No METEG).

3.  If the grammar form is in the Verb Table, and the Verb Binyan ïééðá allows 

Pronominal Suffixes, the next menu item will be Pronominal Suffixes.

4.  If the grammar form selected is the Infinitive, then the last menu item will be 

Infinitive Noun.

The last two menu item commands will display the Pronominal Suffixed Verbal 
Forms / Infinitive Noun Table and show either the Pronominal Suffixed Declensions; 
or Infinitive Noun and Suffixed Declensions of the selected verb form.
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Grammar Form (Grammar Table) Context Menu

When one right-clicks on a grammar form in a Grammar Table, a context menu pops 
up with one to four menu items.

1.  The first menu item is always Copy to Clipboard.

2.  If the grammar form contains a Meteg âúî , then the second menu item  will be 

Copy to Clipboard (No METEG).

3.  If the grammar form is in the Verb Table, and the Verb Binyan ïééðá allows 

Pronominal Suffixes, the next menu item will be Pronominal Suffixes.

4.  If the grammar form selected is the Infinitive, then the last menu item will be 

Infinitive Noun.

The last two menu item commands will display the Pronominal Suffixed Verbal 
Forms / Infinitive Noun Table and show either the Pronominal Suffixed Declensions; 
or Infinitive Noun and Suffixed Declensions of the selected verb form.
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Docking Window Focus: Grammar Table (Window menu)

Sets the Input Focus to the currently active Grammar Table.

Shortcut: Ctrl+1
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Grammar Table menu commands

The File menu offers the following commands:

1 Full View / Restore Toggles the size of the Grammar Table – Full View enlarges or 

shrinks the window so that the entire table is minimally is 
visible.  Restore restores the window size to that last set by 
the user in a mouse-drag operation.

2 Toggle Nikud (Vowels) Toggles the display state of a conjugated/declined grammar 

table between the two Hebrew Spelling Conventions:

1.  àìî  áéúë Ktiv Maley (without vowels)

2.  øñç  áéúë Ktiv Khaser (with vowels)

Shortcut: Alt+K

3 Cycle Alternate Spellings Cycles display of the alternate forms of a conjugated/declined 
grammar table, if alternate forms exist (indicated by an initial 

rendering of the first form in RED.

Shortcut: Alt+A

4 Copy Selected Grammar 
Form

Copies a selected form shown in a conjugated/declined 
grammar table to the clipboard.

5 Select Next Grammar Form Selects/highlights the Next Grammar Form in the Table and 
pops up its transliteration.  If no Grammar Form is currently 
selected, the first form in the table is selected.

Shortcut: Ctrl+G

6 Verbs: Pronominal Suffixed 
Forms

If the Verb Table is displayed, and a form is selected that can 
be declined with pronominal suffixes, opens up the Pronominal 
Suffixed Verbal Forms Table for that form.

7 Verbs: Infinitive Noun Forms If the Verb Table is displayed, and the infinitive form is 
selected, opens up the Infinitive Noun (Pronominal Suffix) 
Table for that form and displays its suffixed declensions.

8 Copy Definition Displays a submenu from which the user can choose to copy 
any or all of the definitions of a word.

9 Print/Preview Displays the Grammar Table Page Settings Property Sheet, 
which allows the user to select page size and margins, and 
then either Print or Print Preview.

A Verb Table Displays and sets Input Focus to the Verb Table (First Tab) in 
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the Grammar Table Window.

B Pronominal Suffixed Verbal 
Forms / Infinitive Noun Table

Displays and sets Input Focus to the Pronominal Suffixed 

Verbal Forms / Infinitive Noun Table (Second Tab) in the 
Grammar Table Window.

C Preposition Table Displays and sets Input Focus to the Preposition Table (Third 
Tab) in the Grammar Table Window.

D Number Table Displays and sets Input Focus to the Number Table (Fourth 
Tab) in the Grammar Table Window.
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Page Settings Property Sheet (Grammar Table Toolbar: Print)

The Page Settings Property Sheet that is brought up by the Grammar Table 

Toolbar Print button allows the user to choose two sets of parameters for printing a 
grammar table:

Page Size
Margins

The Save button will set the current values as the default values to be used for future 
printing of grammar tables.

The Preview button will display the printout on the screen using the specified paper 
size, orientation and margins.

The Print button will begin the printing process.

NOTE: When printing, the user is strongly discouraged from changing the paper size 

and orientation via the Print Dialog’s Properties button, as these will override the 

settings already selected in the Page Settings Property Sheet.

See Print Properties Dialog
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Grammar Table Toolbar

The Grammar Table Toolbar is displayed across the top of the application window, 

below the menu bar.  As a Docking Window, it may be moved anywhere within the 
main window or changed into a floating window.

There are two ways to display or hide the Toolbar:
1. From the Main Menu, Choose View -> Toolbar -> Grammar Table 

Toolbar (Keystrokes: Alt+V, 1, G).
2. Right click in the Toolbar area or on any toolbar or toolbar button (but not 

an edit control or combobox), and select Grammar Table Toolbar from 
the popup menu.

Click To

Show Full View / Restore. Toggles the size of the Grammar Table to Full 
View and back. Full View enlarges or shrinks the window so that the entire 
table is minimally visible.  Restore restores the window size to that last set 

by the user in a mouse-drag operation.  See Full View / Restore

NOTE:  When the Docking Windows and Toolbars are arranged in the same 
layout as when the program was installed (See View menu Commands: 

Reset Docking Windows Layout), the toggle action can be seen properly.  
Sometimes, the windows are docked such that one dimension cannot be 
adjusted.  If toggling with this command does not produce the desired 
results, this is probably the case and can be confirmed by failure of the 
mouse to drag the side that refuses to move.

Also if the screen resolution for your monitor is set to 800 x 600 or less, the 

Restore part of this command may not work.  This happens because when 

the Full View command tries to resize a large Grammar Table, such as the 
Verb Table, the full height is never reached because the window would 
actually be taller than the vertical screen resolution setting.  Therefore 
repeating this command keeps trying to set the full height.  The optimum 

screen resolutions for using SAFFA are 1024 x 768 or 1152 x 864.

Toggle ãå÷éð  Nikud (Vowels). Toggles the display state of a 

conjugated/declined grammar table between the two Hebrew Spelling 
Conventions:

1.  àìî  áéúë Ktiv Maley (without vowels)
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2. øñç  áéúë Ktiv Khaser (with vowels)

See Toggle Nikud (Vowels)

Cycle Alternate Spellings.  Cycles display of the alternate forms of a 
conjugated/declined grammar table, if alternate forms exist (indicated by an 

initial rendering of the first form in RED.  See Cycle Alternate Spellings

Copy Selected Grammar Form.  Copies a selected form shown in a 

conjugated/declined grammar table to the clipboard.  See Copy Selected 
Grammar Form

Print/Preview Grammar Table.  Displays the Grammar Table Page 
Settings Property Sheet, which allows the user to select page size and 

margins, and then either Print or Print Preview.  See Print/Preview
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Grammar Table Window

The Grammar Table Window is a Docking Window (one that the user can set to be 
floating or docked to the main window) with 4 Tab Views:

ìòåô  ("Po-al"=Verb) Verbs.  Displays the Verb Table.

éåðéë  ("Kinui"=Pronoun) Pronominal Suffixed Verbal Forms / Infinitive 

Nouns.  Displays the Pronominal Suffixed Verbal Forms / Infinitive 
Noun Table.

ñçé-î  ("Milat-Yakhas"=Preposition) Prepositions / Particles.  Displays 

the Preposition / Particle Table.

øôñî  ("Mispar"=Number) Numbers.  Displays the Number Table.

As shown above, the label for each tab uses the Hebrew Name for the table rather 
than the English one.  The user need only position the cursor over the Tab itself and a 
ToolTip window will popup showing the English Table Name.
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Edit menu commands

The Edit menu (visible when a document is open) offers the following commands:

Undo Reverses the previous editing operation.
Shortcut: Ctrl+Z

Redo Redo the previously undone editing operation.
Shortcut: Ctrl+Y

Select All Selects all text in the active side of the document

Cut Deletes the selected text from the document and copies it to the 
clipboard.
Shortcut: Ctrl+X

Copy Copies the selected text from the document to the clipboard.
Shortcut: Ctrl+C

Copy Special Pops up the Copy Special Dialog allowing the user to select two 
options for the Copy operation:  Export Filter (None, Microsoft Hebrew 
Standard) and Direction (Forward/Reverse).

Paste Pastes formatted text, if available, otherwise unformatted text, from the 
clipboard into the document.
Shortcut: Ctrl+V

Paste Special Pops up the Paste Special Dialog allowing the user to select various 
options for the Paste operation: Import Filter (None, Microsoft Hebrew 
Standard, DavkaWriter), Direction (Forward/Reverse), and Text Format
 (Plain Text /Rich Text Format).

Reverse Selected Text Reverses the letter order of the selected text.
Shortcut: Ctrl+Shift+R

Insert Page Break Inserts a Hard Page Break into a document.

Find Pops up the Modeless Find Dialog for a search for specified text in the 
document.
Shortcut: Ctrl+F

Find Next After setting up Search parameters using the Find command, finds the 
next instance of the specified text in the document.
Shortcut: F3

Replace Pops up the Modeless Find/Replace Dialog for a search for specified 
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find text and its replacement with specified replace text in the document.
Shortcut: Ctrl+L
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Hebrew Edit Controls Context Menu

When the user right-clicks with the mouse in a Hebrew Edit control, the following menu 
pops up.

Copy Copies the selected text from the document to the clipboard.

Shortcut: Ctrl+C

Copy Special Pops up the Copy Special Dialog allowing the user to select two 

options for the Copy operation: Export Filter (None, Microsoft 

Hebrew Standard) and Direction (Forward, Reverse).

Paste Pastes formatted text, if available, otherwise unformatted text, from 
the clipboard into the document.

Shortcut: Ctrl+V

Paste Special Pops up the Paste Special Dialog allowing the user to select two 

options for the Paste operation: Import Filter (None, Microsoft 

Hebrew Standard) and Direction (Forward, Reverse).

Select All Selects all text in the active side of the document

Cut Deletes the selected text from the document and copies it to the 
clipboard.

Shortcut: Ctrl+X

Remove Vowels and Search This command is found only in the Hebrew Edit Control in the 

Lookup/Search Toolbar.  Removes Vowels from the text in the Edit 

Control, then performs a Hebrew Word Search.

See Hebrew Edit Controls
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Hebrew Edit Controls

The Hebrew Edit Controls are found in the following areas:

(a) the Verb Table (the ‘Shoresh’ edit window).

(b) the Preposition Table (the ‘Preposition’ edit window).

(c) the Lookup/Search Toolbar edit window (to the left of the book and 
binocular buttons).

(d) the Find Dialog ‘Find What’ edit window.

(e) the Find/Replace Dialog ‘Find What’ and ‘Replace With’ edit windows.

(f)  the File Save As Dialog ‘Hebrew File Name’ edit window.

Hebrew Edit Controls let the user enter Hebrew text, via either the keyboard or the 

Keyboard Guides Window.

Hebrew Edit Controls use many of the same keystroke shortcuts as regular Windows 
edit controls, such as:

Ctrl + C Copy See Copy
Ctrl + V Paste See Paste
Ctrl + X Cut See Cut
Ctrl + Z Undo / Redo Undoes / redoes only the last editing operation.

Double-clicking in a Hebrew Edit Control Selects All text in the window.

A Context Menu is also accessible by right-clicking with the mouse.
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Input Mode: Hebrew command (View menu)

Sets the Input Mode for the active document to the Hebrew (right-to-left) side.

NOTE:  The same action can be performed by pressing the Toggle Input Mode button
HID_ENTRY_MODE in the Editor Toolbar.

Shortcut: Ctrl+H

See Editor Window.
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Letter/Vowel Descriptions command (Language Reference menu)
Hebrew Letter/Vowel Descriptions and Usages Dialog

The Letter/Vowel-Descriptions command pops up the the Hebrew Letter/Vowel 
Descriptions and Usages Dialog, an alphabetical layout of button controls 
representing the Hebrew Regular Consonants, Final consonants, Modern Consonants, 
Vowels, Half-Vowels and Diacritical Marks.  Clicking on any Letter/Vowel Button will 

popup a full screen Letter ID Dialog which explains the character’s place in the 

Hebrew orthographic system, and gives a few examples of its usage in some sample 
words.

Shortcuts

KeyStroke Shortcuts on the physical keyboard are available as an alternative to 

clicking with the mouse.  Typing TAB will advance the focus to the next letter/vowel 

button in the Keymap Chart.  Typing Shift-TAB will move the focus backwards.  Typing 

Space or Return will depress the letter/vowel button, and cause the Letter ID window 
for that character to popup.

The user can also use keystroke shortcuts to quickly tab between the groupings of the 
letters:

Alt+C for Consonants.
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Alt+N for Final Consonants.

Alt+R for Modern Consonants.

Alt+O for Vowels.

Alt+K for Khataf-Vowels.

Alt+T for Meteg (diacritical mark).

Alt+D for Dagesh (diacritical mark).

Alt+H for Help.

Alt+X to Exit.
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Hebrew Letter/Vowel Descriptions and Usages: Letter ID Dialog

When you click on a Letter, Vowel or Diacritical Mark button in the Hebrew 

Letter/Vowel Descriptions and Usages Dialog, a full screen popup Window appears 
with an explanation of the Letter or Vowel.

A short description of the character, how it is pronounced, and its place in the Hebrew 
orthographic system occupy the top half of the window.

At the bottom of the window are either 3 or 6 example word buttons (with translations) 
showing the letter/vowel at the beginning, middle and/or end of words.  When you click 
on the example buttons, a popup transliteration of the word appears, with the stressed 

syllable written RED.

In the middle of the page is the àìî áéúë (without vowels) or àìî áéúë 

(with vowels) button, which toggles the example word display between the two 

Hebrew Spelling Conventions: Ktiv Maley (FULL spelling; written without vowels) 

and Ktiv Khaser (MISSING spelling: written with vowels).
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Hebrew Letter/Vowel Map Guide

.

The Hebrew Letter/Vowel Map Guide is accessed through the Letter-Vowel Map Tab

 of the Keyboard Guides Window.

The Hebrew Letter/Vowel Map Guide is an alphabetical layout of button controls 
representing the 22 Hebrew Regular Consonants, the 5 Final Consonants, and 4 
Modern Consonants; as well as the 10 Regular Vowels, the 3 Khataf (Half) Vowels and 
the 2 major Diacritical Marks.  As an alternative to typing directly into a Hebrew 

Document or one of the Hebrew Edit controls, the user can click on these buttons to 
enter text.

When using the Keymap, the output will go to the Document or Hebrew Edit Control 
that last had the focus.  The user can redirect the output to another Document / 
Control by simply clicking in the target window, and then clicking on letter/vowel 
buttons to enter Hebrew text. 

Shortcuts
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KeyStroke Shortcuts on the physical keyboard are available as an alternative to 

clicking with the mouse.  Typing TAB will advance the focus to the next letter/vowel 

button in the Keymap Chart.  Typing Shift-TAB will move the focus backwards.  Typing 

Ctrl+Space will depress the letter/vowel button, entering the character into the Hebrew 

Document or Hebrew Edit control (typing a regular Space enters a space into the 

destination window).  Alt+H will bring up the Help for this window.

The user can also use Keystroke shortcuts to quickly tab between the groupings of the 
letters:

Alt+C for Consonants.

Alt+N for Final Consonants.

Alt+R for Modern Consonants.

Alt+O for Vowels.

Alt+K for Khataf-Vowels.

Alt+T for Meteg (diacritical mark).

Alt+D for Dagesh (diacritical mark).

Alt+H for Help.
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Hebrew List Lookup Button (Lookup/Search Toolbar)

Sets the mode of the mode of the Lookup/Search Toolbar to Hebrew List 
Lookup mode.  The Lookup Tables / Search Results Window  
displays an alphabetical list of over 1,750,000 entries from SAFFA ’s 

Hebrew Word Database.  The List Header displays 10 fields 
categorizing the entries.

When the Lookup/Search Toolbar is set in this mode, as the user enters 
Hebrew Text in the Toolbar’s Edit Control, the Lookup Tables Window 

scrolls to a matching or the closest alphabetical entry in the list.  When 
the user then clicks on an entry, or highlights an entry and presses the 
Enter key, the Grammar Tables Window will then display the entry, 
showing its grammar table context.

See Lookup/Search Toolbar .
See Lookup Tables/ Search Results Window .
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Hebrew List Lookup Button (Lookup/Search Toolbar)

Sets the mode of the mode of the Lookup/Search Toolbar to Hebrew List 

Lookup mode.  The Lookup Tables / Search Results Window displays 

an alphabetical list of over 1,750,000 entries from SAFFA’s Hebrew 

Word Database.  The List Header displays 10 fields categorizing the 
entries.

When the Lookup/Search Toolbar is set in this mode, as the user enters 
Hebrew Text in the Toolbar’s Edit Control, the Lookup Tables Window 

scrolls to a matching or the closest alphabetical entry in the list.  When 
the user then clicks on an entry, or highlights an entry and presses the 

Enter key, the Grammar Tables Window will then display the entry, 
showing its grammar table context.

See Lookup/Search Toolbar.
See Lookup Tables/ Search Results Window.
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Hebrew Word Database

SAFFA’s Hebrew Word Database consists of conjugated forms of verbs, declined 

forms of prepositions/particles and cardinal and ordinal number forms.  The database 
consists of close to 2½ million grammatical forms, with over 1¾ million visible to the 
user.  It also includes a list of approximately 25,000 English definition keywords, that 
is, those words in the definition of a word that are useful when trying to look it up.

For verbs, these also include:
Pronominal Suffixed forms
Infinitive Noun forms (derived from the Infinitive) and their declensions

ûÊ´éää ''''å (Inverted Vav) forms

øöÊ÷î ãéúòãéúòãéúòãéúò  (Future Short) forms for the Paal (ìòòòò´) and Hifil (ìéòòòò
ôä).

The following are not yet included in that portion of the database visible to the user.  
They include:

*÷Êñ´ óÎñ (Pausal) Verb forms

*Lengthened Verb forms of the Future/Imperative (suffixed with a ä, to express 

wish, desire or emphasis)

Nouns with Hebrew based roots.
Nouns that are foreign language cognates.
Adjectives
Adverbs
Conjunctions
Proper nouns
Miscellaneous items.

*These forms occur frequently in the û""""ðú (Bible) and also in poetry. 

The database is not guaranteed to be free from error, and corrections are made over 
time when they come to light.

Updated versions of the database files will be made available on the website (
www.hebrewworks.com) on a regular basis.
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Hebrew Word Search –No Vowels command (Language Reference menu)

Hebrew Word Search – No Vowels command (Editor Window Context Menu)

This command is enabled when the Hebrew side of a document is active and the 
cursor is sitting on top of a word.

The command will first highlight the word in the document; then activate the 

Search/Match Word Button in the Lookup/Search Toolbar; and then copy the word 

(minus vowels and diacritical marks) to the Toolbar’s Edit Control.  SAFFA will then 

perform a search for the word in the Hebrew Word Database.  If matches are found, 

they will be displayed in the Lookup Tables/ Search Results Window.  Finally, the 

Grammar Tables Window will automatically display the first match in the list.

The command removes vowels and diacritical marks ( ùâã Dagesh and âúî 

Meteg) from the text before pasting it into the Lookup/Search Toolbar Edit Control - Î 
(Kholam-with-Vav) and  Ê (Shuruq) are replaced by the consonant å (Vav).

The command is useful for broadening a search when Hebrew Word Search fails to 
find any matches.  Removing vowels and diacritical marks increases the likelihood that 

SAFFA may find (more) matches.  This is a good strategy to follow when trying to 

match anomalous äðåùî (Irregular) forms of Biblical verbs: oftentimes the vowel 

patterns of such forms may differ from what the grammar normally dictates.  It also 

may help when trying to match ÷Êñ´ óÎñ (Pausal) Verb forms.  See Hebrew 

Word and Definitions Database.

Shortcut: Ctrl+Shift+K

NOTE: This same functionality can also be done via the Remove Vowels (and 
Search) command in the Context Menu of the Hebrew Edit Control in the 

Lookup/Search Toolbar.
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Hebrew Word Search Button (Lookup/Search Toolbar)

Sets the mode of the mode of the Lookup/Search Toolbar to Hebrew Word 

Search mode.  The user enters Hebrew text in the Toolbar’s Edit Control 

and then presses the Enter key.  The program will then search the 

Hebrew Word Database, and display likely matches, ranked in order, in 

the Lookup Tables / Search Results Window, if found.  The first entry 
in the list will be highlighted and will automatically be displayed in the 

Grammar Tables Window.  The Header displays 10 fields categorizing 
the entries.

The user may also click on other entries or highlight an entry and press the Enter 

key, causing the Grammar Tables Window to display the entry within its 
grammar table context.

NOTE: When a document is active, pressing the Shortcut sequence 

Ctrl+K will automatically perform a word search for the word on which the 

cursor currently resides.  See  Lookup Word command (Language 

Reference menu).

See Lookup/Search Toolbar.
See Lookup Tables/ Search Results Window.
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Hebrew Word Search command (Language Reference menu)
Hebrew Word Search command (Editor Window Context Menu)

This command is enabled when the Hebrew side of a document is active and the 
cursor is sitting on top of a word.

The command will first highlight the word in the document; then activate the 
Search/Match Word Button  in the Lookup/Search Toolbar ; and then copy the word 
to the Toolbar’s Edit Control.  SAFFA will then perform a search for the word in the 

Hebrew Word Database.  If matches are found, they will be displayed in the Lookup 
Tables/ Search Results Window .  Finally, the Grammar Tables Window will 
automatically display the first match in the list.

Shortcut: Ctrl+K

HINT: If no match is found, try the sister command: Hebrew Word Search – No 

Vowels, which removes vowels from the search text, thereby broadening the search.  
The same thing can be done using the Remove Vowels and Search command in the 
Context Menu of the Hebrew Edit Control in the Lookup/Search Toolbar
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Hebrew Word Search command (Language Reference menu)
Hebrew Word Search command (Editor Window Context Menu)

This command is enabled when the Hebrew side of a document is active and the 
cursor is sitting on top of a word.

The command will first highlight the word in the document; then activate the 

Search/Match Word Button in the Lookup/Search Toolbar; and then copy the word 

to the Toolbar’s Edit Control.  SAFFA will then perform a search for the word in the 

Hebrew Word Database.  If matches are found, they will be displayed in the Lookup 
Tables/ Search Results Window.  Finally, the Grammar Tables Window will 
automatically display the first match in the list.

Shortcut: Ctrl+K

HINT: If no match is found, try the sister command: Hebrew Word Search – No 

Vowels, which removes vowels from the search text, thereby broadening the search.  

The same thing can be done using the Remove Vowels and Search command in the 

Context Menu of the Hebrew Edit Control in the Lookup/Search Toolbar
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Help menu commands

The Help menu offers the following commands, which provide you assistance with this 
application: 

Help Topics Offers you an index to topics on which you can get help.

About Displays the version number of this application.

Register Lets the user purchase and register a copy of this program via the Internet.
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Toggle Input Mode button (Editor Toolbar)

Toggles the Input Mode for the active document from the Hebrew 
(right-to-left) side to the English side, and vice-versa.  When the English side 

is active, the button displays the Letter E.  When the Hebrew side is active, 

the button displays the Hebrew letter Shin  ù.  This button performs the 

same actions as the two View menu commands: Input Mode: Hebrew and 

Input Mode: English.

See Editor Window.

See Editor Toolbar
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Italic Command (Format menu)
Italic Toggle Button (Editor Toolbar)

If text is selected, will add the Italic Font Style to the selection if the first character 
selected is not italicized.
Alternately, if the first character is italicized, the command will remove the Italic Font 
Style from the selection.

If no text is selected, and Italic is selected (button) or checked (menu), the next 
character entered will be italicized.
Alternately, if Italic is unselected (button) or unchecked (menu), the next character 
entered will not be italicized.

Also, if no text is selected, clicking on the Italic button in the Editor Toolbar will toggle 
the setting.

Shortcuts
Key: Ctrl+I

Editor Toolbar: 

NOTE: When navigating through a document, the state of the Italic menu command 
(checked / unchecked) and the state of the Italic button in the Editor Toolbar (pressed 
down, or up) will reflect the style of the character upon which the cursor currently sits.  
If there is a selection, the first character of the selection determines this state.
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Justify: Left, Right, Center (Format menu)
Justify Left, Right Center Toggle Buttons (Editor Toolbar)

This command operates on lines, not characters.  If text is selected, any lines 

included in the selection, including partially selected lines, will be targeted by the 
justification operation.  If there is no selection, only the line on which the cursor 
currently sits will be affected.

NOTE: When navigating through a document, the state of the Justify menu command 
(checked / unchecked) and the state of the Justify button in the Editor Toolbar 
(pressed down, or up) will reflect the style of the line upon which the cursor currently 
sits.  If text is selected and the text spans more than one line, the Justify state seen in 
the menu or Editor Toolbar will reflect the style of the first line of the selection.

Shortcuts

Justify Left: Editor Toolbar: 

Justify Center Editor Toolbar: 

Justify Right Editor Toolbar: 
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Keyboard Guides Window command (View menu)

Use this command to display and hide the Keyboard Guides Window. A check mark 
appears next to the menu item when the Keyboard Guides Window is displayed.

Hiding/Displaying this window can also be done with the mouse.  Right click in the 
Toolbar area or on any toolbar or toolbar button (but not an edit control or combobox), 
and select the appropriate window from the popup menu.

See Keyboard / Keymap Guides Window.
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Keyboard Guides Window

The Keyboard Guides Window is a Docking Window (one that the user can set to 
be floating or docked to the main window).

As shown above, the Keyboard Guides Window has two tabs, each of which offers an 

alternative/aid to entering Hebrew text into the program’s documents and Hebrew Edit 

controls:

The Keyboard Guide is a map depicting the keyboard layout, and shows the 
correspondence between keys on the keyboard and the Hebrew 
consonants, vowels and diacritical marks.  You can use this Guide simply 
as that, a guide to reference as you type on the physical keyboard.  Or 
you can enter text by clicking on the buttons of the Keyboard Guide 

itself.  See Keyboard Guide

The Letter/Vowel Map is a layout showing groups of Hebrew letters and 
vowels.  The 5 main groupings are the 22 Regular Consonants, the 5 
Final Consonants, the 4 Modern Consonants, the 10 Regular Vowels, the 
3 Khataf (Half) Vowels, and the 2 major Diacritical Marks.  As with the 
Keyboard Guide, clicking on the buttons of this Guide allows the user to 

enter text.  See Letter/Vowel Map
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Keyboard Guide

The Hebrew Keyboard Guide is accessed through the Keyboard Guides Tab of the 

Keyboard Guides Window.

The Hebrew Keyboard Guide may be used as a typing reference when typing into a 

Hebrew Document or into one of the Hebrew Edit controls.  See the SAFFA Typing 
Guide Summary.

The Keyboard guide has two representations, one for Unshifted:

and one for Shifted or Caps Lock:
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To change from one to the other, clicking on the Shift or CAPS-LOCK buttons, or 

typing the Shift or CAPS-LOCK keys on the physical keyboard.

You can also use the mouse to click on keys in the Keyboard Guide to enter text.  To 
enter text, first activate the Document or Hebrew Edit control with a mouse click to set 
the target destination.  Then begin clicking on Keys in the Keyboard Guide.  To change 
the target destination, click on a different Document or Hebrew Edit control.

Shortcuts

KeyStroke Shortcuts on the physical keyboard are available as an alternative to 

clicking with the mouse.  Typing TAB will advance the focus to the next letter/vowel 

button in the Keymap Chart.  Typing Shift-TAB will move the focus backwards.  Typing 

Ctrl+Space will depress the letter/vowel button, entering the character into the Hebrew 

Document or Hebrew Edit control (typing a regular Space enters a space into the 

destination window).  Alt+H will bring up the Help for this window.

When one of the HW Fonts is selected, the User can only enter certain punctuation 
marks (the ones not already replace by Hebrew characters) by pressing any key in 
combination with the CTRL key.  For example, Ctrl+Period will enter a period; 
Ctrl+SHIFT+? will enter a question mark.
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Letter/Vowel Descriptions command (Language Reference menu)
Hebrew Letter/Vowel Descriptions and Usages Dialog

The Letter/Vowel-Descriptions command pops up the the Hebrew Letter/Vowel 
Descriptions and Usages Dialog, an alphabetical layout of button controls 
representing the Hebrew Regular Consonants, Final consonants, Modern Consonants, 
Vowels, Half-Vowels and Diacritical Marks.  Clicking on any Letter/Vowel Button will 

popup a full screen Letter ID Dialog which explains the character’s place in the 

Hebrew orthographic system, and gives a few examples of its usage in some sample 
words.

Shortcuts

KeyStroke Shortcuts on the physical keyboard are available as an alternative to 

clicking with the mouse.  Typing TAB will advance the focus to the next letter/vowel 

button in the Keymap Chart.  Typing Shift-TAB will move the focus backwards.  Typing 

Space or Return will depress the letter/vowel button, and cause the Letter ID window 
for that character to popup.

The user can also use keystroke shortcuts to quickly tab between the groupings of the 
letters:

Alt+C for Consonants.
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Alt+N for Final Consonants.

Alt+R for Modern Consonants.

Alt+O for Vowels.

Alt+K for Khataf-Vowels.

Alt+T for Meteg (diacritical mark).

Alt+D for Dagesh (diacritical mark).

Alt+H for Help.

Alt+X to Exit.
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Language Reference menu commands

The Language Reference menu offers the following commands:

Letter/Vowel Descriptions Pops up the Hebrew Letter/Vowel Descriptions and Usages Dialog
, an arrangement of Buttons representing the Hebrew Letters, Vowels, 
and Diacritical Marks.  Clicking on a button pops up a full screen 

Letter ID Dialog which describes the use of the Hebrew character.

Reading Tutorial Pops up the Reading Tutorial Dialog, a series of 24 Lessons and 
Drills covering all the letters, vowels, and diacritical marks used for 
reading the Hebrew Language.

Transliterate: Insert English 
Side

Transliterates the Hebrew side of a Document, or a selected portion, 

and inserts the resulting formatted text into the English Side of the 
Same Document at the English-side cursor position.  The user can 
set the phoneme set and text formatting for this operation in the 
Preferences menu: 

Transliteration Phonemes
TransliterationFormat

Speak/Transliterate: Word If the Hebrew side of a document is active, and the cursor is sitting on 
top of a word, will highlight the word, pronounce it, and popup a 
window containing the word’s transliteration next to it.  Repeated use 

of this command will advance the cursor to successive words, 
pronounce them, and display the transliteration for each one.  The 
user can set both Voice parameters and the Phoneme Set and Font 
for this operation in the Preferences menu: 

Transliteration Phonemes
Voice Settings

Shortcut: Ctrl+W

Speak/Transliterate: 
Sentence

If the Hebrew side of a document is active, and the cursor is sitting 
within a sentence, will highlight the sentence, pronounce it, and popup 
a window containing its transliteration.  Repeated use of this 
command will advance the cursor to successive sentences, 
pronounce them, and display the transliteration for each one.  The 
user can set both Voice parameters and the Phoneme Set and Font 
for this operation in the Preferences menu: 

Transliteration Phonemes
Voice Settings

Shortcut: Ctrl+T
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Speak/Transliterate: 
Selection

If the Hebrew side of a document is active, and a selection of text is 
highlighted, will pronounce the highlighted text, and popup a window 
containing its transliteration.  Repeating this command repeats the 
operation on the same text.  The user can set both Voice parameters 
and the Phoneme Set and Font for this operation in the Preferences 
menu: 

Transliteration Phonemes
Voice Settings

Shortcut: Ctrl+D

Transliterate: New Document Transliterates the Hebrew side of a Document, or a selected portion, 

and inserts the resulting formatted text into a New Document.  The 
user can set the phoneme set and text formatting for this operation in 
the Preferences menu: 

Transliteration Phonemes
TransliterationFormat

Hebrew Word Search This command is enabled when the Hebrew side of a document is 
active and the cursor is sitting on top of a word.

The command will first highlight the word in the document; then 

activate the Search/Match Word Button in the Lookup/Search 

Toolbar; and then copy the word to the Toolbar’s Edit Control.  

SAFFA will then perform a search for the word in the Hebrew Word 
Database.  If matches are found, they will be displayed in the Lookup 
Tables/ Search Results Window.  Finally, the Grammar Tables 
Window will automatically display the first match in the list.

Shortcut: Ctrl+K

Hebrew Word Search – No 

Vowels

Works exactly like Hebrew Word Search, except that the highlighted 

word is pasted into the Lookup/Search Toolbar’s Edit Control 

without vowels and diacritical marks.  In most cases, this broadens 
the search and increases the likelihood of finding matches.

Shortcut: Ctrl+Shift+K
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Hebrew Letter/Vowel Map Guide

.

The Hebrew Letter/Vowel Map Guide is accessed through the Letter-Vowel Map Tab

 of the Keyboard Guides Window.

The Hebrew Letter/Vowel Map Guide is an alphabetical layout of button controls 
representing the 22 Hebrew Regular Consonants, the 5 Final Consonants, and 4 
Modern Consonants; as well as the 10 Regular Vowels, the 3 Khataf (Half) Vowels and 
the 2 major Diacritical Marks.  As an alternative to typing directly into a Hebrew 

Document or one of the Hebrew Edit controls, the user can click on these buttons to 
enter text.

When using the Keymap, the output will go to the Document or Hebrew Edit Control 
that last had the focus.  The user can redirect the output to another Document / 
Control by simply clicking in the target window, and then clicking on letter/vowel 
buttons to enter Hebrew text. 

Shortcuts
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KeyStroke Shortcuts on the physical keyboard are available as an alternative to 

clicking with the mouse.  Typing TAB will advance the focus to the next letter/vowel 

button in the Keymap Chart.  Typing Shift-TAB will move the focus backwards.  Typing 

Ctrl+Space will depress the letter/vowel button, entering the character into the Hebrew 

Document or Hebrew Edit control (typing a regular Space enters a space into the 

destination window).  Alt+H will bring up the Help for this window.

The user can also use Keystroke shortcuts to quickly tab between the groupings of the 
letters:

Alt+C for Consonants.

Alt+N for Final Consonants.

Alt+R for Modern Consonants.

Alt+O for Vowels.

Alt+K for Khataf-Vowels.

Alt+T for Meteg (diacritical mark).

Alt+D for Dagesh (diacritical mark).

Alt+H for Help.
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Lookup/Search Toolbar

The Lookup/Search Toolbar is displayed across the top of the application window, 
below the menu bar.  As a Docking Window, it may be moved anywhere within the 
main window or changed into a floating window.

There are two ways to display or hide the Toolbar:
1. From the Main Menu, Choose View -> Toolbar -> Lookup/Search 

Toolbar (Keystrokes: Alt+V, 1, L).
2. Right click in the Toolbar area or on any toolbar or toolbar button (but not 

an edit control or combobox), and select Lookup/Search Toolbar  from 
the popup menu.

Click To

Enter Lookup or Search Text in Hebrew, or a 
Definition Keyword in English.  See Lookup/Search Toolbar Edit Control .

The Hebrew List Lookup button  sets the Toolbar in Hebrew List Lookup 
Mode.

The Hebrew Word Search button sets the Toolbar in Hebrew Word 
Search Mode.

The English Definition Keywords Lookup button  sets the Toolbar in 
English Definitions Keywords Lookup Mode .

The Lookup /Search Toolbar has three modes, represented by the three buttons 
above.

The first button, the Hebrew List Lookup button , sets the Toolbar and the 
Lookup Tables / Search Results Window  in Hebrew List Lookup 
mode.  The Window displays an alphabetical list of over 1,750,000 
entries from SAFFA’s Hebrew Word Database.  The Header displays 

10 fields categorizing the entries.  As the user enters Hebrew Text in the 
Toolbar’s Edit Control, the Lookup Tables Window scrolls to a matching 

or the closest alphabetical entry in the list.
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The second button, the Hebrew Word Search button, sets the Toolbar and 
the Lookup Tables / Search Results Window  in Hebrew Word Search 
mode.  The user enters Hebrew text in the Toolbar ’s Edit Control and 

then presses the Enter key.  The program will then search the database, 
and display likely matches, ranked in order, if found.  The Header shows 
10 fields categorizing the entries.  The first entry in the list will be 
highlighted and will automatically be displayed in the Grammar Tables 
Window.

If no match is found, you may want to try removing the vowels from the search 
text and trying the search again.  A command to do this can be found in 
the Context Menu of the Hebrew Edit Control in the Lookup/Search 
Toolbar.  See Remove Vowels and Search

When a document is active, pressing the sequence Ctrl+K will automatically 
perform a word search for the word on which the cursor currently 
resides.  See  Hebrew Word Search command (Language Reference 
menu).

The third button, the English Definition Keywords Lookup button  sets the 
Toolbar and the Lookup Tables / Search Results Window  in English 
Definitions Keywords Lookup mode .  The Window displays an 
alphabetical list of approximately 25,000 definition keywords from SAFFA ’

s Hebrew Word Database.  The Header displays 6 fields categorizing 
the entries.  As the user enters English text in the Toolbar ’s Edit Control, 

the Lookup Tables Window scrolls to a matching or the closest 
alphabetical entry in the list.

In any of the above modes, clicking on an entry the Lookup Tables/ Search Results 
Window, or highlighting an entry and pressing the Enter key, will display the entry in 
the Grammar Tables Window.

See Lookup Tables/ Search Results Window .
See Grammar Tables Window.
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Docking Window Focus: Lookup Table/Search Results (Window menu)

Sets the Input Focus to the Lookup Table/Search Results Window.

Shortcut: Ctrl+2
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Lookup Tables / Search Results WIndow

The Lookup Tables / Search Results Window is a Docking Window, where the 
results of operations performed in the Lookup/Search Toolbar  are displayed.

The Window displays lists of information working in conjunction with the 
Lookup/Search Toolbar.  This information is different depending upon the mode of the 
Lookup/Search Toolbar, as follows:

Hebrew List Lookup mode:  This mode is active when the Hebrew List 
Lookup button  (the first button in the Toolbar) is pressed down.  The 
Window displays an alphabetical list of over 1,750,000 entries from 
SAFFA’s Hebrew Word Database.  The Header displays 10 fields 

categorizing the entries.

As the user enters Hebrew Text in the Toolbar ’s Edit Control, the Lookup 

Tables Window scrolls to a matching or the closest alphabetical entry in 
the list.  When the user then clicks on an entry, or highlights an entry and 
presses the Enter key, the Grammar Tables Window will then display 
the entry, showing its grammar table context.

Hebrew Word Search mode:  This mode is active when the Hebrew Word 
Search button (the second button in the Toolbar) is pressed down.  The 
user enters Hebrew text in the Toolbar ’s Edit Control and then presses 

the Enter key.  The program will then search the Hebrew Word 
Database, and display likely matches, ranked in order, if found.  The first 
entry in the list will be highlighted and will automatically be displayed in 
the Grammar Tables Window.  The Header displays 10 fields 
categorizing the entries.

The user may also click on other entries or highlight an entry and press the Enter 
key, causing the Grammar Tables Window to display the entry within its 
grammar table context.

NOTE: When a document is active, pressing the Shortcut sequence 
Ctrl+K will automatically perform a word search for the word on which 
the cursor currently resides.  See  Lookup Word command (Language 
Reference menu).

English Definitions Keywords Lookup mode:  This mode is active when the 
English Definition Keywords Lookup button  (the third button in the 
Toolbar) is pressed down.  The Window displays an alphabetical list of 
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approximately 25000 definition keywords from SAFFA ’s Hebrew Word 

Database.  The Header displays 6 fields categorizing the entries.  As the 
user enters English Text in the Toolbar ’s Edit Control, the Lookup Tables 

Window scrolls to a matching or the closest alphabetical entry in the list.

When the user then clicks on an entry, or highlights an entry and presses 
the Enter key, the Grammar Tables Window will normally display the 
associated grammar table, highlighting the keyword within the definition.  
There are cases, however, when a definition keyword for a verb is part of 
the definition of several of the verbs Binyanim.  In these situations, when 
the entry is clicked, a popup menu will appear, displaying the Binyanim 
where the definition keyword is found:

The user may then scroll in the list and press the Enter key, or click on 
one of the menu selections; the Grammar Tables Window will then 
display the entry, and highlight the keyword within the definition.

See Lookup/Search Toolbar
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Lookup/Search Toolbar

The Lookup/Search Toolbar is displayed across the top of the application window, 

below the menu bar.  As a Docking Window, it may be moved anywhere within the 
main window or changed into a floating window.

There are two ways to display or hide the Toolbar:
1. From the Main Menu, Choose View -> Toolbar -> Lookup/Search Toolbar 

(Keystrokes: Alt+V, 1, L).
2. Right click in the Toolbar area or on any toolbar or toolbar button (but not 

an edit control or combobox), and select Lookup/Search Toolbar from 
the popup menu.

Click To

Enter Lookup or Search Text in Hebrew, or a 

Definition Keyword in English.  See Lookup/Search Toolbar Edit Control.

The Hebrew List Lookup button sets the Toolbar in Hebrew List Lookup 
Mode.

The Hebrew Word Search button sets the Toolbar in Hebrew Word 
Search Mode.

The English Definition Keywords Lookup button sets the Toolbar in 

English Definitions Keywords Lookup Mode.

The Lookup /Search Toolbar has three modes, represented by the three buttons above.

The first button, the Hebrew List Lookup button, sets the Toolbar and the 

Lookup Tables / Search Results Window in Hebrew List Lookup 

mode.  The Window displays an alphabetical list of over 1,750,000 

entries from SAFFA’s Hebrew Word Database.  The Header displays 

10 fields categorizing the entries.  As the user enters Hebrew Text in the 
Toolbar’s Edit Control, the Lookup Tables Window scrolls to a matching 

or the closest alphabetical entry in the list.

The second button, the Hebrew Word Search button, sets the Toolbar and the 
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Lookup Tables / Search Results Window in Hebrew Word Search 

mode.  The user enters Hebrew text in the Toolbar’s Edit Control and 

then presses the Enter key.  The program will then search the database, 

and display likely matches, ranked in order, if found.  The Header shows 
10 fields categorizing the entries.  The first entry in the list will be 

highlighted and will automatically be displayed in the Grammar Tables 
Window.

If no match is found, you may want to try removing the vowels from the search 
text and trying the search again.  A command to do this can be found in 

the Context Menu of the Hebrew Edit Control in the Lookup/Search 

Toolbar.  See Remove Vowels and Search

When a document is active, pressing the sequence Ctrl+K will automatically 
perform a word search for the word on which the cursor currently 

resides.  See  Hebrew Word Search command (Language Reference 
menu).

The third button, the English Definition Keywords Lookup button sets the 

Toolbar and the Lookup Tables / Search Results Window in English 
Definitions Keywords Lookup mode.  The Window displays an 
alphabetical list of approximately 25,000 definition keywords from SAFFA’

s Hebrew Word Database.  The Header displays 6 fields categorizing 
the entries.  As the user enters English text in the Toolbar’s Edit Control, 

the Lookup Tables Window scrolls to a matching or the closest 
alphabetical entry in the list.

In any of the above modes, clicking on an entry the Lookup Tables/ Search Results 
Window, or highlighting an entry and pressing the Enter key, will display the entry in 
the Grammar Tables Window.

See Lookup Tables/ Search Results Window.

See Grammar Tables Window.
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âúî  Meteg

âúî  Meteg (2 meanings: bridle or switch) is a vertical line ( Í ) placed to the left of a 

vowel.  This diacritical mark indicates the primary syllabic stress for a word.  In 
traditional religious texts, words not written with a Meteg are assumed to have ultimate 
(final) syllabic stress.
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Microsoft Standard Hebrew ASCII Table

The following shows the Microsoft Standard Hebrew ASCII Table (the horizontal and 
vertical axes are labeled 0 through F (0 - 15 in the hexadecimal system):

(Positions 20 through 7E are populated with the standard English ASCII values letters, 
numbers, punctuation and symbols.)

The Consonants à  Alef through ú Taf and the five Final Consonants fill positions E0 

through FA at the very high end of the table.

The Vowels fill positions C0 through CD.

C9 and CA are both   É    (Kholam Dot - no Vav).
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CC is  Ì   (Dagesh or Mapiq).

CD is  Í  (Meteg).

D1 is the upper righthand dot marking a Shin Ñ.

D2 is the upper lefthand dot marking a Shin Ò.

In this system, the Vowels Î Kholam-with-Vav and Ê Shuruq are represented as follows:

Î    Kholam-with-Vav is a  å Vav   plus   É    Kholam Dot (C9)

Ê   Shuruq is a  å Vav  plus   Ì   Dagesh (CC).

Consonants with Dagesh are represented with two or even three character-values.

For example, ¡ (Bet) is represented as á (Vet) (E1) + Dagesh (CC).

ÑShin is represented as: F9 + D1.

Ò Sin is represented as: F9 + D2.

Ð Shin (with Dagesh) is represented as: F9 + D1 + Dagesh (CC).
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Pronominal Suffixed Verbal Forms / Infinitive Noun Table

The Pronominal Suffixed Verbal Forms / Infinitive Noun Table is accessed in two 
ways:

1. via the Pronominal Suffixed Verbal Forms / Infinitive Nouns Tab of 

the Grammar Tables Window.

2. via the Pronominal Suffixed Verbal Forms / Infinitive Noun Table 
command in the Grammar Table_menu

The Pronominal Suffixed Verbal Forms / Infinitive Noun Table is automatically 

displayed when the you select the Pronominal Suffixes or Infinitive Noun menu 

items from the Verb Table Context Menu or when you use the Grammar Table_menu
 and select Verbs: Pronominal Suffixed Forms or Verbs: Infinitive Noun Forms.

When showing Pronominal Suffixed Forms, the Table displays the applicable 
pronominal suffix inflected forms of a verb form: each suffixed form represents a 

Person-Gender-Number DIRECT OBJECT combination.

When showing Infinitive Noun Forms, the Table displays the inflected forms of the 
Infinitive Noun: each suffixed form represents a Person-Gender-Number 

POSSESSIVE PRONOUN combination.

You can select a word by either clicking on it or by using the Select Next Grammar 
Form (Shortcut: Ctrl+G) in the Grammar Table_menu.

At the bottom of the Table is the English definition area containing one or more 
definitions, and also indicating the particular Prepositions used with each meaning.  

Right-click over the Definition area to popup the Definition Context Menu, which will 
allow you to copy any or all of the definitions to the clipboard.

There are 2 ways to Print or Preview the Pronominal Suffixed Verbal Forms/Infinitive 
Noun Table:

Click on the Print/Preview button in the Grammar Toolbar.

Use the Print / Preview command from the Grammar Table menu.

Heading
The top of the Table shows three pieces of information.

For Pronominal Suffixed Forms:
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On the left is a summary showing the ïééðá Binyan and the SUBJECT 

Person-Gender-Number classification of the source Verb Form.
In the middle is the source Verb Form that the was selected in the Verb Table.

On the right is the ùøåù Shoresh (Verb Root) of the source Verb Form.

For Infinitive Noun Forms:

On the left is the ïééðá Binyan of the source Verb Infinitive.

In the middle is the derived Infinitive Noun Form with no suffixes.

On the right is the ùøåù Shoresh (Verb Root) of the source Verb Infinitive.

Word Stress

Syllabic stress in a Hebrew Verb is either ultimate (on the last syllable) or 

penultimate (on the second-to-last syllable.  Syllabic stress is assumed to be 

on the last syllable unless the verb form contains a Meteg ( Í ), indicating 

otherwise.

Buttons

Alternate Forms

If in a conjugation, a word form is initially drawn in RED, this indicates 
that the displayed form is one of two or more grammatically correct forms.  By 

successively clicking on the Cycle Alternative Spellings button in the 

Grammar Toolbar, the Pronominal Suffixed Forms / Infinitive Noun Table will 
cycle through displaying each of these forms.  You can accomplish the same 

thing via the Cycle Alternate Spellings command in the Grammar 

Table_menu.

ãå÷éð  Nikud (Vowels)

You can alternate the display of the declined forms between the two 

Hebrew Spelling Conventions: àìî  áéúë Ktiv Maley (without vowels) 
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and øñç  áéúë Ktiv Khaser (with vowels) by clicking on the Toggle 

ãå÷éð  Nikud (Vowels) button in the Grammar Toolbar.  You can 

accomplish the same thing via the Toggle Nikud (Vowels) command in the 

Grammar Table_menu.

Automatic Window Sizing

Use either the Show Full View / Restore button in the Grammar Toolbar

 or the Full View / Restore command in the Grammar Table_menu to 
automatically adjust the size of the Table Window for optimal viewing.

Copying a Word from the Table to the Clipboard

You can copy the selected word (including Meteg, if any) by clicking the 

Copy Selected Grammar Form button in the Grammar Toolbar or by using 

the Copy Selected Grammar Form in the Grammar Table_menu.

Mouse Actions

Transliteration:

Left-click with the mouse over a word form to pop up 

its transliteration.  The stressed syllable is printed RED.  You can change the 

phonemic output of popup transliterations with the Transliteration Phonemes 
command (Preferences menu).

Context menu:

Right-click with the mouse over a word form to 

pop up a context menu.  This menu will contain one or two choices: Copy to 
Clipboard and/or Copy to Clipboard (NO METEG).  See Grammar Form 

(Grammar Table) Context Menu.

For Pronominal Suffixed Forms:
DIRECT OBJECT Person-Gender-Number Explanation:
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Position the mouse cursor over the 
Person-Gender-Number abbreviation to the right of an inflected verb form.  In a 

fraction of a second, a small popup window will appear spelling out the Person 

(First, Second or Third), Gender (Masculine or Feminine), Number (Singular or 

Plural) and the English and Hebrew DIRECT OBJECT pronoun the suffixed 
form is derived from.

For Infinitive Noun Forms:
POSSESSIVE PRONOUN Person-Gender-Number Explanation:

Position the mouse cursor over the 
Person-Gender-Number abbreviation to the right of an Infinitive Noun form.  In a 

fraction of a second, a small popup window will appear spelling out the Person 

(First, Second or Third), Gender (Masculine or Feminine), Number (Singular or 

Plural) and the English and Hebrew POSSESSIVE pronoun from which the 
suffixed form is derived.
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New command (File menu)

Use this command to create a new blank document.

You can open an existing document with the Open command.

Shortcuts

File Toolbar:
Keys: CTRL+N
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ãå÷éð  Nikud

ãå÷éð  Nikud (literally: vocalization) are the dots, lines and other marks that go 

under and above Hebrew Consonant Letters, representing vowels and certain 
diacritical marks.  SAFFA can help you learn about these marks with the Letter/Vowel 
Descriptions and Reading Tutorial commands found under the Language 
Reference menu.
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ãå÷éð  Nikud

ãå÷éð  Nikud (literally: vocalization) are the dots, lines and other marks that go 

under and above Hebrew Consonant Letters, representing vowels and certain 

diacritical marks.  SAFFA can help you learn about these marks with the Letter/Vowel 
Descriptions and Reading Tutorial commands found under the Language 

Reference menu.
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Number Table

The Number Table is accessed in two ways:
1. via the Numbers Tab of the Grammar Tables Window
2. via the Number Table command in the Grammar Table_menu

The Number Calculation Table allows the user to see the full Hebrew word spelling 
of a number in Hebrew.  The Table has 2 modes:

No-Sequence Mode
Sequence Mode with step intervals of 1, 10, 100, and 1000

No-Sequence Mode
In No-Sequence Mode the user can enter a number up to twelve (12) digits long.  The 
Hebrew word spelling of the number will appear in the oversized button control 
immediately below, and its English word spelling will appear just below that.  Clicking 
on the oversized button containing the Hebrew word spelling will popup the number ’s 

transliteration and pronounce it.

Like Hebrew Nouns, Hebrew numbers also have Gender.  Therefore Masculine and 
Feminine radio buttons are provided to show both forms of the number.

Number may also be viewed in both Cardinal (1, 2, 3, etc.) and Ordinal (1st, 2nd, 3rd, 
etc.) forms.

Sequence Mode
In Sequence Mode the user can enter a starting number up to four (4) digits long, that 
is, 0 through 9999.  The table will calculate the successive sequential numbers and 
their word spellings, using a sequence differential or step interval of the selected 
number: 1, 10, 100 or 1000.  For example, if 10 is the starting number and the 
differential is also 10, then the sequence of numbers that will be shown will be 10, 20, 
30, 40, 50, 60, 70, 80, 90, and 100. The numbers ’ word spellings can also be viewed 

in their Masculine/Feminine and Cardinal/Ordinal forms.

Printing / Previewing

If a Document is open, there are only two ways to print/preview:
1. In the Main Menu, Select Grammar Table -> Print/Preview Grammar Table
2. Click on the Printer button in the Grammar Toolbar

If a Document is not open, there are two more methods:
3. In the Main Menu, Select File -> Print Preview, or File -> Print
4. Click on the Printer button in the File Toolbar
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Keyboard Shortcuts

As an alternative to the mouse, the user can navigate through the Table as follows:

Use TAB to move to the next edit control, group of radio controls or buttons.
Use SHIFT + TAB to move to the previous edit control, group of radio controls 

or buttons.
Use the SPACEBAR to simulate clicking on a button to popup its transliteration.

You can select a word by either clicking on it or by using the Select Next Grammar 
Form (Shortcut: Ctrl+G) in the Grammar Table_menu.

Buttons

ãå÷éð  Nikud (Vowels)

You can alternate the display of the Hebrew word spellings of the 

numbers between the two Hebrew Spelling Conventions : àìî  áéúë Ktiv 

Maley (without vowels) and øñç  áéúë Ktiv Khaser (with vowels) by clicking 

on the Toggle ãå÷éð  Nikud (Vowels) button in the Grammar Toolbar.  You 

can accomplish the same thing via the Toggle Nikud (Vowels)  command in 
the Grammar Table_menu.

Automatic Window Sizing

Use either the Show Full View / Restore button in the Grammar 
Toolbar or the Full View / Restore command in the Grammar Table_menu to 
automatically adjust the size of the Table Window for optimal viewing.

Copying a Word from the Table to the Clipboard

You can copy the selected word (including Meteg, if any) by clicking the 
Copy Selected Grammar Form button in the Grammar Toolbar or by using 
the Copy Selected Grammar Form in the Grammar Table_menu.
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Page Setup Command (Format menu)
Page Settings Property Sheet

The Page Setup Property Sheet allows the user to choose three sets of parameters for 
a document:

Page Size
Margins
Tab Positions

The user has the choice of applying the values to:
1. the Current Page Only
2. the Current Page and all succeeding Pages
3. the Entire Document.

Normally, the values are applied only to the active side (Hebrew / English) of the 

document.  If the Apply Settings to BOTH sides box is checked, the values will be 
assigned to both sides of a document.

The Save button will set the current values as the default values to use for any new 

pages or future documents.  Again if the Apply Settings to BOTH sides box is 
checked, the current values will be used as the default values for both sides of a 
document; otherwise only the active side.
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Page Settings Property Sheet: Margins

The Margins Property Page of the Page Settings Property Sheet allows the user to 
select right, left, top, and bottom margins.

NOTE for Documents: When the page is displayed on the screen, the user will see by 
the ruler markings that only the printable area of the page as defined by these margins 
will be visible.  If the margins are different for the two sides of the page, the areas of 
the rulers displayed in Yellow (for the top ruler) and Pink (for the side ruler) are the 
printable area of the page for the Active Side of the document.  Areas of the ruler that 
are gray show the outside areas of the printable page of the Inactive Side of the 
document.
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Page Settings Property Sheet: Paper Size

The Page Size Property Page of the Page Settings Property Sheet allows the user to 
select the Paper Size to be used and the orientation (Portrait or Landscape) to be 
printed.  The Paper Sizes include all paper sizes supported by any printers installed on 

the computer.  The last item in the list is Custom.  When selected, the user may enter 

the values for the page size in the Width and Length fields.

NOTE for Documents: SAFFA supports the use of different page sizes within a single 
document.  Although this feature will probably be used sparingly in actual practice, the 
most common use would be in a document of one paper size, but with some pages in 
Portrait orientation and some in Landscape.

Return to Contents Page 133



Page Settings Property Sheet: Tab Positions

The Tabs Property Page of the Page Settings Property Sheet allows the user to 
select both tabs repeatedly spaced at regular intervals, and custom tabs to be placed 
at irregular positions on the page.

The tab settings are calculated from the left margin of the document’s English side, 

and the right margin of the Hebrew side.

Repeated interval tabs will only start to be positioned after the last custom tab.  For 

example, if the user sets custom tabs at 2" and 3", and also uses a value of ½" for 
repeated interval tabs, the tab positions will be placed as follows, in distance from the 
appropriate margin edge:

2", 3", 3½", 4", 4½", 5", 5½", etc.

Return to Contents Page 134



Paste command (Edit menu)
Paste command (Editor Window Context Menu)
Paste command (Hebrew Edit Controls Context Menu)

Pastes text from the clipboard after the cursor.

When pasting into a Hebrew Edit Control, the text is inserted as plain text 
(unformatted) only.

When pasting into a Document, the text is inserted as RTF (Rich Text Format) text, by 
default.

Shortcuts

Editor Toolbar:
Key: CTRL+V

Return to Contents Page 135



Paste Special command (Edit menu)
Paste Special Dialog
Paste Special command (Editor Window Context Menu)
Paste Special command (Hebrew Edit Controls Context Menu)

Pops up the Paste Special Dialog, which allows the user three preferences for a 

Document and the first two preferences for a Hebrew Edit Control:

Direction: Forward / Reverse

Import Filter: (1) None / (2) Microsoft Hebrew Standard encoded text./  (3)

 DavkaWriter  /  ( 4) UTF-8 Unicode  /  (5) Wide Character Unicode

Text Format: RTF (Rich Text Format) / Plain Text (unformatted) (available 

only for a Document)

The Direction option is useful when copying between right-to-left and left-to-right 

applications or from one side of a Saffa document to the other.

The Import Filter option is useful when copying from another application (word 

processor, browser page displaying Hebrew) to Saffa.

When pasting into a Hebrew Edit Control, the text is inserted as plain text 
(unformatted) only.

When pasting into a Document, text inserted as RTF (Rich Text Format) text is pasted 
with the same formatting characteristics (bold, italic, underline, font size, typeface, 

style, color) as the source it was copied from.  When pasting as plain text 
(unformatted), the text will be formatted using the same formatting characteristics as 
the letter at the insertion point.

Sequence Ordering Encoding Options
This is an option for how to encode the two visually identical, but different, letters:

The Vowel Kholam (when it appears with a Vav beneath it): pronounced OH; 
and

Vav vocalized with a Kholam (when the Kholam appears only as a Dot): 

pronounced VOH.

The first option (VAV + KHOLAM-DOT = KHOLAM) is used In most encoding 
specifications, and is the default option.

However, on occasion, when importing as UTF-8 Unicode, one may require the 
second option (KHOLAM-DOT + VAV = KHOLAM).  For strictly word processing 
purposes, this setting does not matter.

For programs like Saffa, where the difference is recognizable through the 
pronunciations and transliterations, this setting is crucial.
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Shortcuts

Editor Toolbar:
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Preferences menu commands

The Preferences menu (visible when a document is open) offers the following 
commands:

Transliteration Phonemes Pops up the Transliteration Phoneme Set Dialog, in which the 
user can specify and define sets of letter combinations for the 
Hebrew sounds when displaying pop-up or document 
transliterations.  The user may also specify any TrueType font for 
the display of the pop-up transliteration, including any foreign 
ASCII font.  The 6 default sets include English, French, German, 
Spanish, and Russian (2 sets).  The values in the set are used in 

the five Transliteration Commands found under the Language 
Reference Menu:

Transliterate: Insert English Side
Transliterate: New Document
Speak/Transliterate: Word
Speak/Transliterate: Sentence
Speak/Transliterate: Selection

Transliteration Format Pops up the Transliteration Document Format Dialog, in which 
the user can define various formatting parameters to be used in 
the text output of translierations used in two of the Transliteration 

Commands found under the Language Reference Menu:

Transliterate: Insert English Side
Transliterate: New Document

Parameters are defined for stressed/non-stressed syllables, and 
include options for font, color, capitalization, hyphenation, and 
inter-word spacing.

Settings Pops up the Settings Dialog in which the user can specify options 
for:

HaShem Filter;
Color for Kamats Katan;
Hebrew Pronunciation (Accent, Vowel Quality)
Nikud Toggle

Voice Settings Pops up the Voice Settings Dialog in which the user can specify 
parameters for Speaking of Hebrew text, including Speed, Volume, 
Pitch, and Gender, among others.  The user may also specify 
choice of a talking character.
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Preposition / Particle Table

The Preposition / Particle Table is accessed in two ways:
1. via the Prepositions/Particles Tab of the Grammar Tables Window
2. via the Preposition Table command  in the Grammar Table_menu

The Preposition / Particle Table displays a list of approximately 60 Declinable 
Prepositions and Particles in its main list box control.  As the user scrolls through the 
list, the selected preposition or particle is displayed in the Hebrew Edit control just 
above.  By double-clicking on a selected preposition or by hitting the Entry key on the 
keyboard, a table of the preposition ’s declined forms is displayed.  Notice that some 

prepositions are declined using a singular-noun paradigm  (like ìöà or ãáì) while 

others are declined using a plural-noun paradigm (like éøçà or ìà).  A few (like 

éøä or ïî) are declined idiosyncratically.

You can select a word by either clicking on it or by using the Select Next Grammar 
Form (Shortcut: Ctrl+G) in the Grammar Table_menu.

At the bottom of the Table is the English definition  area containing one or more 
definitions.  In most cases, a list of the pronouns associated with the declined forms 
appears within a set of purple square brackets.  Right-click over the Definition area to 
popup the Definition Context Menu , which will allow you to copy any or all of the 
definitions to the clipboard.

There are 2 ways to Print or Preview the Preposition/Particle Table:

Click on the Print/Preview button in the Grammar Toolbar.
Use the Print / Preview command from the Grammar Table menu.

Word Stress

Syllabic stress in a Hebrew Verb is either ultimate (on the last syllable) or 
penultimate (on the second-to-last syllable.  Syllabic stress is assumed to be 

on the last syllable unless the verb form contains a Meteg ( Í ), indicating 

otherwise.

Buttons

Alternate Forms
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If in a conjugation, a word form is initially drawn in RED, this indicates 
that the displayed form is one of two or more grammatically correct forms.  By 
successively clicking on the Cycle Alternative Spellings button in the 
Grammar Toolbar, the Preposition/Particle Table will cycle through displaying 
each of these forms.  You can accomplish the same thing via the Cycle 
Alternate Spellings command in the Grammar Table_menu.

ãå÷éð  Nikud (Vowels)

You can alternate the display of the declined forms between the two 

Hebrew Spelling Conventions : àìî  áéúë Ktiv Maley (without vowels) and 

øñç  áéúë Ktiv Khaser (with vowels) by clicking on the Toggle ãå÷éð  

Nikud (Vowels) button in the Grammar Toolbar.  You can accomplish the 
same thing via the Toggle Nikud (Vowels)  command in the Grammar 
Table_menu.

Automatic Window Sizing

Use either the Show Full View / Restore button in the Grammar 
Toolbar or the Full View / Restore command in the Grammar Table_menu to 
automatically adjust the size of the Table Window for optimal viewing.

Copying a Word from the Table to the Clipboard

You can copy the selected word (including Meteg, if any) by clicking the 
Copy Selected Grammar Form button in the Grammar Toolbar or by using 
the Copy Selected Grammar Form in the Grammar Table_menu.

Mouse Actions

Transliteration:

Left-click with the mouse over a word form to pop up 
its transliteration.  The stressed syllable is printed RED.  You can change the 
phonemic output of popup transliterations with the Transliteration Phonemes 
command (Preferences menu).

Context menu:

Right-click with the mouse over a 
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preposition/particle or one of its declined forms to pop up a context menu.  This 
menu will contain one or two choices: Copy to Clipboard and/or Copy to 
Clipboard (NO METEG).  See Grammar Form (Grammar Table) Context 
Menu.

SUFFIX Person-Gender-Number Explanation :

Position the mouse cursor over the 
Person-Gender-Number abbreviation to the right of a verb form.  In a fraction of 
a second, a small popup window will appear spelling out the Person (First, 
Second or Third), Gender (Masculine or Feminine) and Number (Singular or 
Plural) that the suffix of the form indicates.
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Print / Preview command (Grammar Table menu)

This command displays the Grammar Table Page Settings Property Sheet, which 
allows the user to select page size and margins, and then either Print or Print Preview.

Shortcut

Grammar Toolbar: 

See Page Settings Property Sheet (Grammar Table Toolbar: Print)
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Print Properties Dialog

The Print Properties Dialog pops up when the user presses the Properties button 

from either the Print Dialog or the Print Setup Dialog.

WARNING: Use of the Print Properties Dialog to change the Paper 

Size or Orientation settings already specified by the Page Settings 
Property Sheet (Format menu) or the Page Settings Property Sheet 

(Grammar Table Toolbar: Print) is STRONGLY DISCOURAGED as the 
new settings will override those selected earlier.

The Print Properties Dialog is divided into four sections:

Paper:  Lets the user change the Paper Size, Orientation and Paper Source.  

The user may safely change only the Paper Source.

Graphics:  Lets the user choose values for  Resolution, Dithering and 

Intensity.

Fonts:  Lets the user choose how to download TrueType fonts: either as 

Bitmap Soft Fonts or as Graphics (default setting).
Device Options:  Lets the user choose the value for Printer Memory Tracking.

For Help on what any of these options mean, first click on the Question mark 
button in the Dialog’s upper right corner; then click on the area you want 

help for.
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Verb Table

The Verb Table is accessed in two ways:
1. via the Verbs Tab of the Grammar Tables Window
2. via the Verb Table command in the Grammar Table_menu

The Verb Table displays a list of over 3000 verbal íéùøåù Shorashim (Verb Roots) 

in its main list box control.  As the user scrolls through the list, the selected ùøåù 

Shoresh is displayed in the Hebrew Edit control just above.  In the ïééðá Binyan 

area below the list box, the grammatically- applicable Binyan radio buttons for the 
selected Shoresh are enabled (not every Shoresh can be conjugated with all 7 
Binyanim).  Clicking on one of these radio buttons will fill the table with a display of the 
conjugations for that Binyan of the grammatically-applicable Tenses (Infinitive, 
Present, Past, Future, Imperative, and Participle/Adjective).

You can select a word by either clicking on it or by using the Select Next Grammar 
Form (Shortcut: Ctrl+G) in the Grammar Table_menu.

Just below the Shoresh list box is the Patterns Combobox with two conjugation 
options: Regular Patterns (the default) and VAV Inversive.  VAV-Inversive forms are 

a biblical grammatical form: the meaning of a past form prefixed with a å  VAV 

(translated as and or but) changes to the future tense, and vice-versa, hence the 
name Inversive.  In certain cases (such as with future tense Paal-Kal forms of the 

Shoresh äìò), the form of the verb may change as well (to the øöå÷î (shortened) 

form).

At the bottom of the Verb Table is a list of the Prepositions that the verb can be used 
with.

Below the Prepositions area is the English definition  area containing one or more 
definitions, and also indicating the particular Prepositions used with each meaning.  
Right-click over the Definition area to popup the Definition Context Menu , which will 
allow you to copy any or all of the definitions to the clipboard.

There are 2 ways to Print or Preview the Verb Table:

Click on the Print/Preview button in the Grammar Toolbar.
Use the Print / Preview command from the Grammar Table menu.

Word Stress
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Syllabic stress in a Hebrew Verb is either ultimate (on the last syllable) or 
penultimate (on the second-to-last syllable.  Syllabic stress is assumed to be 

on the last syllable unless the verb form contains a Meteg ( Í ), indicating 

otherwise.

Buttons

Alternate Forms

If in a conjugation, a verb form is initially drawn in RED, this indicates 
that the displayed form is one of two or more grammatically correct forms.  By 
successively clicking on the Cycle Alternative Spellings button in the 
Grammar Toolbar, the Verb Table will cycle through displaying each of these 
forms.  You can accomplish the same thing via the Cycle Alternate Spellings 
command in the Grammar Table_menu.

ãå÷éð  Nikud (Vowels)

You can alternate the display of the conjugated forms between the two 

Hebrew Spelling Conventions : àìî  áéúë Ktiv Maley (without vowels) and 

øñç  áéúë Ktiv Khaser (with vowels) by clicking on the Toggle ãå÷éð  

Nikud (Vowels) button in the Grammar Toolbar.  You can accomplish the 
same thing via the Toggle Nikud (Vowels)  command in the Grammar 
Table_menu.

Automatic Window Sizing

Use either the Show Full View / Restore button in the Grammar 
Toolbar or the Full View / Restore command in the Grammar Table_menu to 
automatically adjust the size of the Table Window for optimal viewing.

Copying a Word from the Table to the Clipboard

You can copy the selected word (including Meteg, if any) by clicking the 
Copy Selected Grammar Form button in the Grammar Toolbar or by using 
the Copy Selected Grammar Form in the Grammar Table_menu.

Mouse Actions

Transliteration:
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Left-click with the mouse over a verb form to 
pop up its transliteration.  The stressed syllable is printed RED.  You can 
change the phonemic output of popup transliterations with the Transliteration 
Phonemes command (Preferences menu) .

Context menu:

Right-click with the mouse over a verb form to 
pop up a context menu.  This menu will contain one to four choices: Copy to 
Clipboard, Copy to Clipboard (NO METEG) , Pronominal Suffixes and 
Infinitive Noun.  See Grammar Form (Grammar Table) Context Menu.  The 
last two menu item commands will show the Pronominal Suffixed Verbal 
Forms / Infinitive Noun Table  and display either the Pronominal Suffixed 
Declensions; or Infinitive Noun and Suffixed Declensions of the selected verb 
form.

SUBJECT Person-Gender-Number Explanation :

Position the mouse cursor over the 
Person-Gender-Number abbreviation to the right of a verb form.  In a fraction of 
a second, a small popup window will appear spelling out the Person (First, 
Second, Third or all), Gender (Masculine, Feminine, or both), Number 
(Singular or Plural) and the English and Hebrew SUBJECT pronouns that can 
precede the form.
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Keyboard Guides Window command (View menu)

Use this command to display and hide the Keyboard Guides Window. A check mark 
appears next to the menu item when the Keyboard Guides Window is displayed.

Hiding/Displaying this window can also be done with the mouse.  Right click in the 
Toolbar area or on any toolbar or toolbar button (but not an edit control or combobox), 
and select the appropriate window from the popup menu.

See Keyboard / Keymap Guides Window.
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Transliterate: Insert English Side command (Language Reference menu)

Transliterates the Hebrew side of a Document, or a selected portion, and inserts the 

resulting RTF (formatted) text into the English side of the same Document after the 
English-side cursor position.  The user can set the phoneme set and text formatting 
parameters for this operation in the Preferences menu.

See Transliteration Phonemes
See TransliterationFormat
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Pronominal Suffixed Verbal Forms / Infinitive Noun Table

The Pronominal Suffixed Verbal Forms / Infinitive Noun Table is accessed in two 
ways:

1. via the Pronominal Suffixed Verbal Forms / Infinitive Nouns Tab of 

the Grammar Tables Window.

2. via the Pronominal Suffixed Verbal Forms / Infinitive Noun Table 
command in the Grammar Table_menu

The Pronominal Suffixed Verbal Forms / Infinitive Noun Table is automatically 

displayed when the you select the Pronominal Suffixes or Infinitive Noun menu 

items from the Verb Table Context Menu or when you use the Grammar Table_menu
 and select Verbs: Pronominal Suffixed Forms or Verbs: Infinitive Noun Forms.

When showing Pronominal Suffixed Forms, the Table displays the applicable 
pronominal suffix inflected forms of a verb form: each suffixed form represents a 

Person-Gender-Number DIRECT OBJECT combination.

When showing Infinitive Noun Forms, the Table displays the inflected forms of the 
Infinitive Noun: each suffixed form represents a Person-Gender-Number 

POSSESSIVE PRONOUN combination.

You can select a word by either clicking on it or by using the Select Next Grammar 
Form (Shortcut: Ctrl+G) in the Grammar Table_menu.

At the bottom of the Table is the English definition area containing one or more 
definitions, and also indicating the particular Prepositions used with each meaning.  

Right-click over the Definition area to popup the Definition Context Menu, which will 
allow you to copy any or all of the definitions to the clipboard.

There are 2 ways to Print or Preview the Pronominal Suffixed Verbal Forms/Infinitive 
Noun Table:

Click on the Print/Preview button in the Grammar Toolbar.

Use the Print / Preview command from the Grammar Table menu.

Heading
The top of the Table shows three pieces of information.

For Pronominal Suffixed Forms:
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On the left is a summary showing the ïééðá Binyan and the SUBJECT 

Person-Gender-Number classification of the source Verb Form.
In the middle is the source Verb Form that the was selected in the Verb Table.

On the right is the ùøåù Shoresh (Verb Root) of the source Verb Form.

For Infinitive Noun Forms:

On the left is the ïééðá Binyan of the source Verb Infinitive.

In the middle is the derived Infinitive Noun Form with no suffixes.

On the right is the ùøåù Shoresh (Verb Root) of the source Verb Infinitive.

Word Stress

Syllabic stress in a Hebrew Verb is either ultimate (on the last syllable) or 

penultimate (on the second-to-last syllable.  Syllabic stress is assumed to be 

on the last syllable unless the verb form contains a Meteg ( Í ), indicating 

otherwise.

Buttons

Alternate Forms

If in a conjugation, a word form is initially drawn in RED, this indicates 
that the displayed form is one of two or more grammatically correct forms.  By 

successively clicking on the Cycle Alternative Spellings button in the 

Grammar Toolbar, the Pronominal Suffixed Forms / Infinitive Noun Table will 
cycle through displaying each of these forms.  You can accomplish the same 

thing via the Cycle Alternate Spellings command in the Grammar 

Table_menu.

ãå÷éð  Nikud (Vowels)

You can alternate the display of the declined forms between the two 

Hebrew Spelling Conventions: àìî  áéúë Ktiv Maley (without vowels) 
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and øñç  áéúë Ktiv Khaser (with vowels) by clicking on the Toggle 

ãå÷éð  Nikud (Vowels) button in the Grammar Toolbar.  You can 

accomplish the same thing via the Toggle Nikud (Vowels) command in the 

Grammar Table_menu.

Automatic Window Sizing

Use either the Show Full View / Restore button in the Grammar Toolbar

 or the Full View / Restore command in the Grammar Table_menu to 
automatically adjust the size of the Table Window for optimal viewing.

Copying a Word from the Table to the Clipboard

You can copy the selected word (including Meteg, if any) by clicking the 

Copy Selected Grammar Form button in the Grammar Toolbar or by using 

the Copy Selected Grammar Form in the Grammar Table_menu.

Mouse Actions

Transliteration:

Left-click with the mouse over a word form to pop up 

its transliteration.  The stressed syllable is printed RED.  You can change the 

phonemic output of popup transliterations with the Transliteration Phonemes 
command (Preferences menu).

Context menu:

Right-click with the mouse over a word form to 

pop up a context menu.  This menu will contain one or two choices: Copy to 
Clipboard and/or Copy to Clipboard (NO METEG).  See Grammar Form 

(Grammar Table) Context Menu.

For Pronominal Suffixed Forms:
DIRECT OBJECT Person-Gender-Number Explanation:
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Position the mouse cursor over the 
Person-Gender-Number abbreviation to the right of an inflected verb form.  In a 

fraction of a second, a small popup window will appear spelling out the Person 

(First, Second or Third), Gender (Masculine or Feminine), Number (Singular or 

Plural) and the English and Hebrew DIRECT OBJECT pronoun the suffixed 
form is derived from.

For Infinitive Noun Forms:
POSSESSIVE PRONOUN Person-Gender-Number Explanation:

Position the mouse cursor over the 
Person-Gender-Number abbreviation to the right of an Infinitive Noun form.  In a 

fraction of a second, a small popup window will appear spelling out the Person 

(First, Second or Third), Gender (Masculine or Feminine), Number (Singular or 

Plural) and the English and Hebrew POSSESSIVE pronoun from which the 
suffixed form is derived.
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Reading Tutorial (Language Reference menu)

The Reading Tutorial consists of 24 phonetic lessons, progressively enabling the 
user to read all pointed Hebrew text (i.e. text written with vowels).  The 
consonant-letters, vowels, and the two major diacritical marks are introduced by 
name and function.  Words in each lesson build upon consonants and vowels 
already introduced.

Clicking on the words in the word-example buttons in the center will pop-up a 

transliteration.  The stressed syllable will be drawn in RED.

The button below the word-example buttons, is alternately labeled àìî áéúë 

(without vowels) or àìî áéúë (with vowels), and toggles the display of the 

words between the two Hebrew Spelling Conventions: Ktiv Maley (FULL 

spelling; written without vowels) and Ktiv Khaser (MISSING spelling: written with 
vowels).
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Redo command (Edit menu)
Redo Toggle Button (Editor Toolbar)

Redoes/un-reverses the last undo operation.

Shortcuts

Editor Toolbar:
Key: CTRL+Y

NOTE:  When a document is saved, the Undo/Redo List is emptied and it is no longer 
possible to undo/redo prior editing operations.

See Undo command (Edit menu)
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Remove Vowels (and Search)

This command is found in the Context Menu of the Hebrew Edit Control in the 
Lookup/Search Toolbar .

The command first removes vowels and diacritical marks ( ùâã Dagesh and âúî 

Meteg) from the text in the Edit Control - Î (Kholam-with-Vav) and  Ê (Shuruq) are 

replaced by the consonant å (Vav).  When the Toolbar is in Hebrew List Lookup 

Mode, the list in the Lookup Tables/ Search Results Window  will self-scroll to a new 
alphabetical position.  When the Toolbar is in Hebrew Word Search Mode, a Hebrew 
Word Search on the text is performed and any matching entries will be displayed in 
the Lookup Tables/ Search Results Window .

The command is useful for broadening a search when Hebrew Word Search fails to 
find any matches.  Removing vowels and diacritical marks increases the likelihood that 
SAFFA may find (more) matches.  This is a good strategy to follow when trying to 

match anomalous äðåùî (Irregular) forms of Biblical verbs: oftentimes the vowel 

patterns of such forms may differ from what the grammar normally dictates.  It also 

may help when trying to match ÷Êñ´ óÎñ (Pausal) Verb forms, which have not yet 

been catalogued in this application.  See Hebrew Word and Definitions Database .

See also: Hebrew Word Search – No Vowels
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Remove Vowels (and Search)

This command is found in the Context Menu of the Hebrew Edit Control in the 

Lookup/Search Toolbar.

The command first removes vowels and diacritical marks ( ùâã Dagesh and âúî 

Meteg) from the text in the Edit Control - Î (Kholam-with-Vav) and  Ê (Shuruq) are 

replaced by the consonant å (Vav).  When the Toolbar is in Hebrew List Lookup Mode

, the list in the Lookup Tables/ Search Results Window will self-scroll to a new 

alphabetical position.  When the Toolbar is in Hebrew Word Search Mode, a Hebrew 

Word Search on the text is performed and any matching entries will be displayed in 

the Lookup Tables/ Search Results Window.

The command is useful for broadening a search when Hebrew Word Search fails to 
find any matches.  Removing vowels and diacritical marks increases the likelihood that 

SAFFA may find (more) matches.  This is a good strategy to follow when trying to 

match anomalous äðåùî (Irregular) forms of Biblical verbs: oftentimes the vowel 

patterns of such forms may differ from what the grammar normally dictates.  It also 

may help when trying to match ÷Êñ´ óÎñ (Pausal) Verb forms, which have not yet 

been catalogued in this application.  See Hebrew Word and Definitions Database.

See also: Hebrew Word Search – No Vowels

Return to Contents Page 156



Replace command (Edit menu)
Replace Dialog

The Replace Dialog lets the user search the active document for either English or 
Hebrew text, and replace it with user-specified text, including no text at all.

When the English radio button is checked, the user may enter English text from the 
keyboard.

When the Hebrew radio button is checked, the user may enter Hebrew text using 

either the keyboard or one of the Keyboard Guides.

Text can be entered into both the Find What and Replace With Edit Controls.  

Pressing the Down Arrow to the right of each displays a list of the 10 most-recent 

Find What or Replace With texts.

The user may do forward searches by checking the Down radio button; or reverse 

searches by checking the Up radio button.

When doing searches for English text, the user has two options:

Match Whole Word Only
Match Case.

When doing searches for Hebrew text, the user has three options:

Match Whole Word Only
Match Vowels
Match Dagesh.

These options are explained below:

Match Whole Word Only If checked, the search will match only if the search 
text is not part of a larger word.  Punctuation is treated like white space.

Match Case If checked, the search is case-sensitive (English text only)

Match Vowels If checked, the search is vowel-sensitive.  A 
consonant/vowel pair in the search text must match its counterpart’s 

consonant/vowel pair in order to match.  When considering whether to 

match, the Diacritical mark âúî  Meteg is ignored; that is, vowels with 

Meteg will match the same vowel without Meteg.  If this option is 
unchecked, the search will ignore Hebrew vowels altogether.

Match Dagesh If checked, the search is ùâã  Dagesh-sensitive.  

Consonants will match only if they both have or both don’t have the 

diacritical mark Dagesh.  If this option is unchecked, the search will 

ignore Dagesh marks within a consonant.

The user has two ways to conduct the replace operation.  He/she can replace any 
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matched instances of the Find What text with the Replace With text all at once 

(globally) by pressing the Replace All button.  Or the user may replace matches on an 
individual basis; when a match is found, the user may replace the matched text by 

pressing the Replace button, or may skip the replace operation for that match by 

pressing the Find Next button.

Shortcut
Key: Ctrl + L
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Reset Docking Windows Layout command (View menu)

Use this command to reset the Docking Windows and Toolbar Layouts to Installation 
Values.  This command can be used when Docking Windows or Toolbars seem 
resistant to being docked at desired positions.

See Docking Window.
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SAFFA Hebrew ASCII Table

The picture below shows SAFFA’s Hebrew ASCII Table.

The characters that SAFFA uses occupy positions 160 –254 (Hexadecimal: A0 – FE).  

The basic letters and vowels occupy the same positions as in the Microsoft Standard 
Hebrew ASCII Table.  However, SAFFA requires additional characters in order to 

represent letters such as the consonants with ùâã  Dagesh, the vowels with âúî  

Meteg, and several others.
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SAFFA Hebrew ASCII Table

The picture below shows SAFFA’s Hebrew ASCII Table.

The characters that SAFFA uses occupy positions 160 –254 (Hexadecimal: A0 – FE).  

The basic letters and vowels occupy the same positions as in the Microsoft Standard 

Hebrew ASCII Table.  However, SAFFA requires additional characters in order to 

represent letters such as the consonants with ùâã  Dagesh, the vowels with âúî  

Meteg, and several others.

Return to Contents Page 161



Hebrew Spelling Conventions
Hebrew Word and Definitions Database
Microsoft Standard Hebrew ASCII Table
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Typing Guide Summary
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Save As command (File menu)

Use this command to save and name the active document.  SAFFA displays the File 
Save As Dialog, which allows the user to navigate the file system, save the active 
document and choose a Windows system file name, and an optional internal Hebrew 
File Name.

To save a document with its existing name and directory, use the Save command.

NOTE:  When a document is saved, the Undo/Redo List is emptied and it is no longer 
possible to undo/redo prior editing operations.

See Redo command (Edit menu)
See Undo command (Edit menu)
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Select Next Grammar Form command (Grammar Table menu)

This command selects and highlights the Next Grammar Form in the Table and pops 
up its transliteration.  If no Grammar Form is currently selected, the first form in the 
table is selected.

NOTE:  A grammar form can also be selected by clicking on it with the mouse.

Shortcut: Ctrl+G
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Shoresh ùøåù (root)

In the Hebrew Verb System, there are approximately 3000 verbal íéùøåù 

Shorashim (roots).  A verbal ùøåù Shoresh (root) usually has 3 letters, but may on 

occasion have 4, or rarely 5, letters.  A particular root may be used for several different 
words, whose semantics, or meanings, may or may not be related, simply by changing 
the sequence of vowels in the word and by adding prefixes and/or suffixes.

NOTE: The Hebrew word for ‘Verb’ is ìòåô Po-al, and in the grammar 

system, each of the three letter positions is given a name.

The first letter is called ô""""äô  Pey Ha-Poal.

The second letter is called ô""""äò  Ayin Ha-Poal.

The third letter is called ô""""äì  Lamed Ha-Poal.

With most roots, all letters are grammatically significant and are conjugated in a 
regularly.  However, several groups of 3-letter roots are conjugated irregularly, and 
their roots are also classified differently.

One of these irregular verb groups is called å""""ò  éçð  Nakhey Ayin-Vav (second 

letter is å Vav) and é""""ò  éçð  Nakhey Ayin-Yud (second letter is é Yud).  Verbs in 

this group use a placeholder ‘weak’ second letter between two grammatically 

significant letters.  This second letter is often dropped during conjugation.

Another irregular group is called ä""""ì  Lamed-Hey (third letter is ä Hey).  Verbs in 

this group often drop the third letter during conjugation.

Still another irregular group is called íéìôåë K’fulim (doubled), in which the 

second and third letters are identical, or doubled.  Verbs in this group may be 
conjugated regularly, or may drop one of the doubled letters during conjugation.
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Keyboard Guides Window command (View menu)

Use this command to display and hide the Keyboard Guides Window. A check mark 
appears next to the menu item when the Keyboard Guides Window is displayed.

Hiding/Displaying this window can also be done with the mouse.  Right click in the 
Toolbar area or on any toolbar or toolbar button (but not an edit control or combobox), 
and select the appropriate window from the popup menu.

See Keyboard / Keymap Guides Window.
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Toolbar commands (View menu)

Use these commands to display and hide any of the 4 Toolbars.  A check mark 
appears next to the menu item when the a particular Toolbar is displayed.

Hiding/Displaying a toolbar can also be done with the mouse.  Right click in the 
Toolbar area or on any toolbar or toolbar button (but not an edit control or combobox), 
and select the desired Toolbar from the popup menu.

See File Toolbar.

See Editor Toolbar.

See Grammar Table Toolbar.

See Lookup/Search Toolbar.
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Speak/Transliterate: Sentence command (Language Reference menu)

If the Hebrew side of a document is active, and the cursor is sitting within a sentence, 
this command will highlight the sentence, pronounce it, and popup a window 
containing transliteration for the text.  Stressed syllables of words will be shown in RED
.  Repeated use of this command will advance the cursor to successive sentences, 
pronounce them, and display the transliteration for the text.  The user can set both the 
Voice Settings and the Phoneme Set and Font for this operation in the Preferences 
menu.

You can stop the Voice from speaking at any time by clicking anywhere within the 
talking face; or by clicking anywhere within the Grammar Table area; or by clicking in 
or typing in any Document window.

See Transliteration Phonemes
See Voice Settings

Shortcut: Ctrl+T
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Speak/Transliterate: Text button (Editor Toolbar)

Clicking this button works as follows:

If the Control key is held down, the action taken will be the same as for the 
Speak/Transliterate: Word command.

If the Shift key is held down, the action taken will be the same as for the 
Speak/Transliterate: Sentence  command.

If NO key is held down then:

If a selection of text is highlighted, the action taken will be the same as for the 
Speak/Transliterate: Selection  command.

Otherwise the action taken will be the same as for the Speak/Transliterate: 
Word command.

The user can set both the Voice Settings and the Phoneme Set and Font for this 
operation in the Preferences menu.

You can stop the Voice from speaking at any time by clicking anywhere within the 
talking face; or by clicking anywhere within the Grammar Table area; or by clicking in 
or typing in any Document window.

See Transliteration Phonemes
See Voice Settings
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Speak/Transliterate: Word command (Language Reference menu)

If the Hebrew side of a document is active, and the cursor is sitting on top of a word, 
this command will highlight the word, pronounce it, and popup a window containing the 
word’s transliteration next to it.  The stressed syllable will be shown in RED.  Repeated 

use of this command will advance the cursor to successive words, pronounce them, 
and display the transliteration for each one.  The user can set both the Voice Settings 
and the Phoneme Set and Font for this operation in the Preferences menu.

You can stop the Voice from speaking at any time by clicking anywhere within the 
talking face; or by clicking anywhere within the Grammar Table area; or by clicking in 
or typing in any Document window.

See Transliteration Phonemes
See Voice Settings

Shortcut: Ctrl+W
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Speak/Transliterate: Word command (Language Reference menu)

If the Hebrew side of a document is active, and the cursor is sitting on top of a word, 
this command will highlight the word, pronounce it, and popup a window containing the 

word’s transliteration next to it.  The stressed syllable will be shown in RED.  Repeated 

use of this command will advance the cursor to successive words, pronounce them, 
and display the transliteration for each one.  The user can set both the Voice Settings 
and the Phoneme Set and Font for this operation in the Preferences menu.

You can stop the Voice from speaking at any time by clicking anywhere within the 
talking face; or by clicking anywhere within the Grammar Table area; or by clicking in 
or typing in any Document window.

See Transliteration Phonemes

See Voice Settings

Shortcut: Ctrl+W
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øñç  áéúë  Ktiv Maley (Missing Spelling: with Vowels)

Ktiv Khaser  øñç  áéúë  (literally Missing or Absent writing) is one of the two

spelling conventions in Hebrew.

 Words are written with all vowels and diacritical marks .  In this convention, words 
are generally shorter than in Ktiv Maley.  This spelling convention is used less 
frequently in Modern Israel, but is found in childrens books, traditional religious texts 
(such as prayer books), and so forth.  It is much more widely used throughout Jewish 
communities outside of Israel, especially in religious educational materials.

See Hebrew Spelling Conventions
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Hebrew Spelling Conventions

There are two spelling conventions in Hebrew:

1. Ktiv Maley  àìî  áéúë  (literally Full Writing): Words are written

without vowels and diacriticals.   In this convention, however, words
are generally longer, because extra consonants, such as Vav, Yud and
Alef, are added in place of the vowels, to aid in pronunciation and
differentiation between words.  This spelling convention is used widely in
the State of Israel, and mainly in secular uses of the language, such as
books, newspapers, road signs, and so forth.

2. Ktiv Khaser  øñç  áéúë  (literally Missing or Absent writing).

Words are written with all vowels and diacritical marks .  In this
convention, words are generally shorter than in Ktiv Maley.  This spelling
convention is used less frequently in Modern Israel, but is found in
childrens books, traditional religious texts (such as prayer books), and so
forth.  It is much more widely used throughout Jewish communities
outside of Israel, especially in religious educational materials.
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øñç  áéúë  Ktiv Maley (Missing Spelling: with Vowels)

Ktiv Khaser  øñç  áéúë  (literally Missing or Absent writing) is one of the two 

spelling conventions in Hebrew.

 Words are written with all vowels and diacritical marks.  In this convention, words 

are generally shorter than in Ktiv Maley.  This spelling convention is used less 
frequently in Modern Israel, but is found in childrens books, traditional religious texts 
(such as prayer books), and so forth.  It is much more widely used throughout Jewish 
communities outside of Israel, especially in religious educational materials.

See Hebrew Spelling Conventions

Return to Contents Page 175



Microsoft Standard Hebrew ASCII Table

The following shows the Microsoft Standard Hebrew ASCII Table (the horizontal and 
vertical axes are labeled 0 through F (0 - 15 in the hexadecimal system):

(Positions 20 through 7E are populated with the standard English ASCII values letters, 
numbers, punctuation and symbols.)

The Consonants à  Alef through ú Taf and the five Final Consonants fill positions E0 

through FA at the very high end of the table.

The Vowels fill positions C0 through CD.

C9 and CA are both   É    (Kholam Dot - no Vav).
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CC is  Ì   (Dagesh or Mapiq).

CD is  Í  (Meteg).

D1 is the upper righthand dot marking a Shin Ñ.

D2 is the upper lefthand dot marking a Shin Ò.

In this system, the Vowels Î Kholam-with-Vav and Ê Shuruq are represented as follows:

Î    Kholam-with-Vav is a  å Vav   plus   É    Kholam Dot (C9)

Ê   Shuruq is a  å Vav  plus   Ì   Dagesh (CC).

Consonants with Dagesh are represented with two or even three character-values.

For example, ¡ (Bet) is represented as á (Vet) (E1) + Dagesh (CC).

ÑShin is represented as: F9 + D1.

Ò Sin is represented as: F9 + D2.

Ð Shin (with Dagesh) is represented as: F9 + D1 + Dagesh (CC).
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Switch Font Command / Dialog (Format menu)
Switch to Previously Used Font Dialog

Allows the user, while editing, to quickly switch back and forth to fonts used previously 
in the active document.  This command is useful as an alternative to tediously locating 
and selecting the same font over and over from the toolbar or fonts dialogs.

If only two (2) fonts have been used thus far, the command will simply reflect the 
option to switch to the other font, listing the font family, size, and style.

If more than two fonts have been used, the command will Pop up the Switch to 
Previously Used Font Dialog .  The Dialog will display a list of all of the fonts used in 
the active document, excluding the font currently in use.  The user need only select 
his/her choice with a double-click of the mouse or Arrow / Enter keys.

The next character to be typed will begin using the previously used font.

If only one (1) font has been used thus far, the command is grayed (inactive).

Shortcut
Key: Ctrl+Shift+F
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Tile Horizontal command (Window menu)

Use this command to horizontally arrange multiple opened windows one on top of 
another.  The windows do not overlap.

Return to Contents Page 179



Tile Vertical command (Window menu)

Use this command to vertically arrange multiple opened windows side by side.  The 
windows do not overlap.

Return to Contents Page 180



Toggle Nikud (Vowels) command (Grammar Table menu)

This command toggles the display state of a conjugated or declined grammar table 

between the two Hebrew Spelling Conventions:

1.  àìî  áéúë Ktiv Maley (without vowels)

2.  øñç  áéúë Ktiv Khaser (with vowels)

Shortcuts

Grammar Toolbar: 
Keys:  Alt+K

See Nikud  ãå÷éð
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Toolbar commands (View menu)

Use these commands to display and hide any of the 4 Toolbars.  A check mark 
appears next to the menu item when the a particular Toolbar is displayed.

Hiding/Displaying a toolbar can also be done with the mouse.  Right click in the 
Toolbar area or on any toolbar or toolbar button (but not an edit control or combobox), 
and select the desired Toolbar from the popup menu.

See File Toolbar.

See Editor Toolbar.

See Grammar Table Toolbar.

See Lookup/Search Toolbar.
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Transliterate: New Document command (Language Reference menu)

Transliterates the Hebrew side of a Document, or a selected portion, and inserts the 
resulting formatted text into a New Document.  The user can set the phoneme set 
and text formatting parameters for this operation in the Preferences menu.

See Transliteration Phonemes
See TransliterationFormat
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Transliterate: Insert English Side command (Language Reference menu)

Transliterates the Hebrew side of a Document, or a selected portion, and inserts the 
resulting RTF (formatted) text into the English side of the same Document  after the 
English-side cursor position.  The user can set the phoneme set and text formatting 
parameters for this operation in the Preferences menu.

See Transliteration Phonemes
See TransliterationFormat
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Transliteration Format command (Preferences Menu)
Transliteration Document Format Dialog

Allows the user to define various formatting parameters to be used in the RTF text 
output of transliterations used in two of the Transliteration Commands found under the 

Language Reference Menu.

Parameters, which are defined separately for the Stressed and Non-Stressed 
syllables of a word, include:

1. Font: Typeface, Size and Style
2. Text Color and Background Color
3. All Letters in Syllable to be Capitalized

One can also set parameters for Word units:
1. Hyphenation between syllables
2. Extra Inter-Word Spacing
3. First Letter of each Word to be Capitalized

There is also a setting for Line units:
First Letter of each Line to be Capitalized

The Sample area shows typical transliteration output as you select the various 
parameters.

NOTE:  When you are choosing a background color, you also have the choice of No 
Color (transparent background).

See Transliterate: Insert English Side
See Transliterate: New Document
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Transliteration Phonemes command (Preferences Menu)
Transliteration Phoneme Set Dialog

Allows the user to alter the Phoneme Set for Transliteration Purposes.

The Transliteration Phoneme Set Dialog displays a layout of the Vowels, Diphthongs 
and Consonants needed to represent Hebrew pronunciation in transliteration.  Each 
phoneme value has two items:

1. An edit control containing the letters in the user’s native language that 

will be used for the sound in the transliteration.
2. Examples of one or more English words containing the sound.

The user may define a new set of phonemes for the transliteration scheme from 
scratch; or s/he may use or redefine any of 6 default schemes given for English, 
French, Spanish, German and Russian (Russian has 2 sets, depending upon whether 
the display font uses the CP1251 or KOI8-R ASCII schemes).  

NOTE: If you want to use characters from the upper 128 ASCII values of a particular 
font (values 129-255), you can enter them in one of two ways:

• Copy the letter to the clipboard from another program (such as the Windows 

System Program Character Map),and then paste; or

• Use the ALT + 0 + ASCII-value keystroke sequence.  For example, if you 

wanted to enter the German character ß (ASCII value 223) , you would press 

and hold down the ALT key, then press the sequence of numbers: 0  2  2  3.

The user may also choose any TrueType font for the rendering of the pop-up 
transliterations.

The phoneme set chosen by the user will be used in the five Transliteration 

Commands found under the Language Reference Menu.

See Transliterate: Insert English Side

See Transliterate: New Document
See Speak/Transliterate: Word

See Speak/Transliterate: Sentence

See Speak/Transliterate: Selection
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SAFFA Typing Guide Summary

The SAFFA typing positions of the main Hebrew consonants are for the most part the 

standard used on all Hebrew keyboards.  These include the letters à Alef (ASCII Hex 

E0) through ú Taf (ASCII Hex FA), accessed with the Shift key up; and their 

corresponding representations with either Dagesh or Mapiq (a small dot inside the 
letter), accessed with the Shift key down.

Differences occur on the SAFFA keyboard for the following letters:

• the consonants Shin Ñ and Sin Ò.

• the modern consonants, which correspond to sounds in borrowed foreign words.

• special representations for Final-Khaf ê with vowels and dagesh.

• the vowels.

These differences are summarized below:

Letter Keyboard Position Phoneme

Ñ Shin w

Ð Shin with Dagesh W

Ò Sin q

Ó Sin with Dagesh Q

Ü Gimel-Apostrophe G J (as 

in John)

Ý Zayin-Apostrophe J

Zh (as in Zsa-Zsa)

ß Tsadi-Apostrophe T Ch 

(as in Chuck)

Þ Final-Tsadi-Apostrophe > Closing Angle Bracket Ch 

(as in Hatch)

û Final-Khaf with Shva [ Opening Square Bracket

ü Final-Khaf with Kamats { Opening Curly Bracket

» Final-Kaf with Shva + Plus Sign

¼ Final-Kaf with Kamats |  Vertical Bar
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Vowel Keyboard Position

À     Shva ' Apostophe

Å    Tsereh " Quotation Marks

Ä      Khiriq / Forward Slash

Î    Kholam (with Vav) O Capital-O

É      Kholam (Dot only) ? Question Mark

È    Kamats ] Closing Square Bracket

Ã   Khataf-Kamats } Closing Curly Bracket

Ç   Patakh - Hyphen

Ç    Khataf-Patakh _ Underscore

Æ    Segol ` Back Apostophe

Á   Khataf-Segol ~ Tilde

Ë    Qubuts \ Back Slash

Ê   Shuruq I Capital-I

Diacritical Marks Keyboard Position

Ì     Dagesh / Mapiq : Colon

Í     Meteg = Equal Sign
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Underline Command (Format menu)
Underline Toggle Button (Editor Toolbar)

If text is selected, will add the Underline Font Style to the selection if the first character 
selected is not underlined.
Alternately, if the first character is underlined, the command will remove the Underline 
Font Style from the selection.

If no text is selected, and Underline is selected (button) or checked (menu), the next 
character entered will be underlined.
Alternately, if Underline is unselected (button) or unchecked (menu), the next character 
entered will not be underlined.

Also, if no text is selected, clicking on the Underline button in the Editor Toolbar will 
toggle the setting.

Shortcuts
Key: Ctrl+U

Editor Toolbar: 

NOTE: When navigating through a document, the state of the Underline menu 
command (checked / unchecked) and the state of the Underline button in the Editor 
Toolbar (pressed down, or up) will reflect the style of the character upon which the 
cursor currently sits.  If there is a selection, the first character of the selection 
determines this state.
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Undo command (Edit menu)
Undo Toggle Button (Editor Toolbar)

Undoes/reverses the last editing operation.

Shortcuts

Editor Toolbar:
Key: CTRL+Z

NOTE:  When a document is saved, the Undo/Redo List is emptied and it is no longer 
possible to undo/redo prior editing operations.

See Redo command (Edit menu)
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Verb Table command (Grammar Table menu)

This command displays and sets the Input Focus to the Shoresh Edit Control of the 

Verb Table (First Tab) in the Grammar Table Window.

See Verb Table
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Verb Table

The Verb Table is accessed in two ways:

1. via the Verbs Tab of the Grammar Tables Window
2. via the Verb Table command in the Grammar Table_menu

The Verb Table displays a list of over 3000 verbal íéùøåù Shorashim (Verb 

Roots) in its main list box control.  As the user scrolls through the list, the selected 

ùøåù Shoresh is displayed in the Hebrew Edit control just above.  In the ïééðá 

Binyan area below the list box, the grammatically- applicable Binyan radio buttons for 
the selected Shoresh are enabled (not every Shoresh can be conjugated with all 7 
Binyanim).  Clicking on one of these radio buttons will fill the table with a display of the 

conjugations for that Binyan of the grammatically-applicable Tenses (Infinitive, 
Present, Past, Future, Imperative, and Participle/Adjective).

You can select a word by either clicking on it or by using the Select Next Grammar 
Form (Shortcut: Ctrl+G) in the Grammar Table_menu.

Just below the Shoresh list box is the Patterns Combobox with two conjugation 

options: Regular Patterns (the default) and VAV Inversive.  VAV-Inversive forms are 

a biblical grammatical form: the meaning of a past form prefixed with a å  VAV 

(translated as and or but) changes to the future tense, and vice-versa, hence the 

name Inversive.  In certain cases (such as with future tense Paal-Kal forms of the 

Shoresh äìò), the form of the verb may change as well (to the øöå÷î 

(shortened) form).

At the bottom of the Verb Table is a list of the Prepositions that the verb can be used 
with.

Below the Prepositions area is the English definition area containing one or more 
definitions, and also indicating the particular Prepositions used with each meaning.  

Right-click over the Definition area to popup the Definition Context Menu, which will 
allow you to copy any or all of the definitions to the clipboard.

There are 2 ways to Print or Preview the Verb Table:

Click on the Print/Preview button in the Grammar Toolbar.

Use the Print / Preview command from the Grammar Table menu.
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Word Stress

Syllabic stress in a Hebrew Verb is either ultimate (on the last syllable) or 

penultimate (on the second-to-last syllable.  Syllabic stress is assumed to be 

on the last syllable unless the verb form contains a Meteg ( Í ), indicating 

otherwise.

Buttons

Alternate Forms

If in a conjugation, a verb form is initially drawn in RED, this indicates that 
the displayed form is one of two or more grammatically correct forms.  By 

successively clicking on the Cycle Alternative Spellings button in the 

Grammar Toolbar, the Verb Table will cycle through displaying each of these 

forms.  You can accomplish the same thing via the Cycle Alternate Spellings 

command in the Grammar Table_menu.

ãå÷éð  Nikud (Vowels)

You can alternate the display of the conjugated forms between the two 

Hebrew Spelling Conventions: àìî  áéúë Ktiv Maley (without vowels) 

and øñç  áéúë Ktiv Khaser (with vowels) by clicking on the Toggle 

ãå÷éð  Nikud (Vowels) button in the Grammar Toolbar.  You can 

accomplish the same thing via the Toggle Nikud (Vowels) command in the 

Grammar Table_menu.

Automatic Window Sizing

Use either the Show Full View / Restore button in the Grammar Toolbar
 or the Full View / Restore command in the Grammar Table_menu to 
automatically adjust the size of the Table Window for optimal viewing.

Copying a Word from the Table to the Clipboard

You can copy the selected word (including Meteg, if any) by clicking the 

Copy Selected Grammar Form button in the Grammar Toolbar or by using 

the Copy Selected Grammar Form in the Grammar Table_menu.
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Mouse Actions

Transliteration:

Left-click with the mouse over a verb form to 

pop up its transliteration.  The stressed syllable is printed RED.  You can 

change the phonemic output of popup transliterations with the Transliteration 
Phonemes command (Preferences menu).

Context menu:

Right-click with the mouse over a verb form to 

pop up a context menu.  This menu will contain one to four choices: Copy to 
Clipboard, Copy to Clipboard (NO METEG), Pronominal Suffixes and 

Infinitive Noun.  See Grammar Form (Grammar Table) Context Menu.  The 

last two menu item commands will show the Pronominal Suffixed Verbal 
Forms / Infinitive Noun Table and display either the Pronominal Suffixed 
Declensions; or Infinitive Noun and Suffixed Declensions of the selected verb 
form.

SUBJECT Person-Gender-Number Explanation:

Position the mouse cursor over the 
Person-Gender-Number abbreviation to the right of a verb form.  In a fraction of 

a second, a small popup window will appear spelling out the Person (First, 

Second, Third or all), Gender (Masculine, Feminine, or both), Number (Singular 

or Plural) and the English and Hebrew SUBJECT pronouns that can precede 
the form.
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Verbs: Infinitive Noun Forms command (Grammar Table menu)

When the Verb Table is displayed, and the infinitive form is selected, this command 
opens up the Infinitive Noun (Pronominal Suffixed Verbal Forms) Table for that form, 
and displays its suffixed declensions.

NOTE:  This command can also be accessed via a context menu if you right click on 
the verb form.

See Verb Table
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Verbs: Pronominal Suffixed Forms command (Grammar Table menu)

When the Verb Table is displayed, and a form is selected that can be declined with 
pronominal suffixes, this command opens up the Pronominal Suffixed Verbal Forms 
Table for that form.

NOTE:  This command can also be accessed via a context menu if you right click on 
the verb form.

See Verb Table
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View menu commands

The View menu offers the following commands:

1 Toolbars Toggles showing and hiding of each of the four toolbars: 
File: Toolbar
Editor Toolbar
Grammar Table Toolbar
Lookup/Search Toolbar

2 Status Bar Toggles showing and hiding of the Status Bar (at the bottom of the 
main window).

3 Grammar Tables Window Toggles showing and hiding of the Grammar Tables Window

4 Lookup Tables/Search 
Results Window

Toggles showing and hiding of the Lookup Tables/Search Results 
Window

5 Keyboard Guides Window Toggles showing and hiding of the Keyboard Guides Window

6 Reset Docking Windows 
Layout

Resets the Docking Windows and Toolbar Layouts to Installation 
Values.  Can be used when Docking Windows seem resistant to 
being docked at desired positions.

7 Input Mode: Hebrew Sets the Input Mode for the active document to the Hebrew 
(right-to-left) side.
Shortcut: Ctrl+H

8 Input Mode: English Sets the Input Mode for the active document to the English 
(left-to-right) side.
Shortcut: Ctrl+E

9 Refresh Text Refresh drawing of text for Both Sides of the active document.
Shortcut: Ctrl+R
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Voice Settings command (Preferences Menu)
Voice Settings Dialog

Allows the user to define and specify various parameters for the Speaking of Hebrew 
Text.

Eight (8) default Voices are provided, whose parameters the user may change.  The 
user may also define new Voices, using the following parameters: 

Speed (slow to fast)

Volume (soft to loud)

Pitch (base pitch for the voice)

Gender (male, female)

Head Size (the larger the head, the deeper the sound)

Pitch Fluctuation (flat robotic to large pitch fluctuations)

Roughness (smooth to rough)

Breathiness (clear to very breathy)

The user can also choose among four (4) talking characters: Golda, Star of David, 
Dreidel or Menorah (or None).

The choice of sampling frequency allows the user to choose the optimal output 
waveform for the resident computer: 8000 Hz provides the worst quality, 22050 Hz the 
best.

NOTE:  In cases when the user has entered a Hebrew word in a document that has 
the following two properties:

1.  the word has No Vowels, and

2.  the word is not yet in Saffa’s Database.

then, when told to pronounce the word, Saffa will instead say either:

úøëåî  àì  äìéî  (mi-LA  lo  mu-KE-ret), which means "Unknown Word

"; or

íéøëåî  àì  úåáéú  éùàø  (ro-SHEY  te-VOT lo  mu-ka-RIM), 

which means "Unknown Abbreviation".
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Window menu commands

The Window menu offers the following commands for rearranging Document Windows, 
and allows the user to set the input focus to:various work areas in the main window 
using the menu or keyboard, as alternatives to the mouse.

Cascade Arranges windows in an overlapped fashion.

Tile Horizontal Arranges windows Horizontally in non-overlapped tiles.

Tile Vertical Arranges windows Vertically in non-overlapped tiles.

Arrange Icons Arranges icons of closed windows.

A  Active Document Focus Sets Input Focus to the currently active Document.

Shortcut: Ctrl+0

B  Docking Window Focus: Grammar Table Sets Input Focus to the currently active Grammar Table
Shortcut: Ctrl+1

C  Docking Window Focus: Lookup 
Table/Search Results

Sets Input Focus to the Lookup Table/Search Results
Window.

Shortcut: Ctrl+2

D  Docking Window Focus: Keyboard Guides Sets Input Focus to either the Keyboard Guide or the 

Letter/Vowel Map (whichever is currently active) in the

Keyboard Guides Docking Window.

Shortcut: Ctrl+3

E  Lookup/Search Toolbar Focus: Hebrew 
List Lookup Mode

Sets Input Focus to the Lookup/Search Toolbar and sets

the Toolbar to Hebrew List Lookup Mode.

Shortcut: Ctrl+4

F  Lookup/Search Toolbar Focus: Hebrew 
Word Search Mode

Sets Input Focus to the Lookup/Search Toolbar and sets

the Toolbar to Hebrew Word Search Mode.

Shortcut:Ctrl+5

G  Lookup/Search Toolbar Focus: English 
Definitions Keywords Lookup Mode

Sets Input Focus to the Lookup/Search Toolbar and sets

the Toolbar to  English Definitions Keywords Lookup 
Mode.

Shortcut: Ctrl+6

H  Editor Toolbar Focus: Font Typeface 
ComboBox

Sets Input Focus to the Font Typeface ComboBox Button
in the Editor Toolbar.

Shortcut: Ctrl+7
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I  Editor Toolbar Focus: Font Size ComboBox Sets Input Focus to the Font Size ComboBox Button
Editor Toolbar.

Shortcut: Ctrl+8

J  Editor Toolbar Focus: Color ComboBox Sets Input Focus to the Color ComboBox Buttonin the
Editor Toolbar.

Shortcut: Ctrl+9

1, 2, 3, 4, etc. + Document Title Sets the Input Focus to the specified open Document.
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